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Preface

Thanks!

Thanks for your interest in developing applications for Android! Android has grown
from nothing to the world’s most popular smartphone OS in a few short years.
Whether you are developing applications for the public, for your business or
organization, or are just experimenting on your own, I think you will find Android to
be an exciting and challenging area for exploration.

And, most of all, thanks for your interest in this book! I sincerely hope you find it
useful and at least occasionally entertaining.

Prerequisites

This book is written for developers with prior experience in Java or Kotlin. If you
are not familiar with either of these languages, it will be difficult for you to follow
the code samples in the book. The author of this book has published Elements of
Kotlin, also freely available.

This book is written for people who have used an Android device before. If you are
not familiar with basic Android concepts — such as the home screen and launcher,
navigating home and back, and so on — you will want to spend time with an
Android device.

Source Code and Its License

The source code in this book is licensed under the Apache 2.0 License, in case you
have the desire to reuse any of it.

Xi
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PREFACE

Copying source code directly from the book, in the PDF editions, works best with
Adobe Reader, though it may also work with other PDF viewers. Some PDF viewers,
for reasons that remain unclear, foul up copying the source code to the clipboard
when it is selected.

Acknowledgments
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Introducing Android

No doubt, you are in a hurry to get started with Android application development.
After all, you are reading this book, aimed at busy coders.

However, before we dive into getting tools set up and starting in on actual
programming, it is important that we “get on the same page” with respect to several
high-level Android concepts. This will simplify further discussions later in the book.

Focus: Apps, Not Operating Systems

This book is focused on writing Android applications (“apps”). An app is something
that a user might install from the Play Store or otherwise download to their device.

That app usually has some user interface, and it might have other code designed to

work in the background.

This book is not focused on modifications to the Android firmware, such as writing
device drivers. For that, you will need to seek other resources.

What You Need

In order to get started as an Android developer — and to get the most out of this
book — you are going to need several things, outlined in the following sections.

A Development Machine

For the purposes of this book, you will need a Windows, macOS, or Linux computer
on which to write your Android apps. This is how the vast majority of Android app
developers do their work, though there are tools (e.g., AIDE) that allow you to write

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.


https://www.opersys.com/

INTRODUCING ANDROID

Android apps directly on an Android device.
Your development machine should be as powerful as you can manage:

+ A fast CPU (e.g., quad-core Intel Core i5/i7/ig with at least 2.0 GHz clock
speed per core)

+ As much RAM as you can manage (8GB minimum, 16GB or more
recommended)

+ As fast of a hard drive as you can find (an SSD is an excellent choice in
general)

* A screen with enough resolution to use the development tools (1280x800
minimum resolution)

The primary development tool for Android apps — called Android Studio —
consumes a lot of resources, particularly when compiling a project, which is why it
helps to have a powerful development machine.

Note that Apple M1 chip support is still a work in progress. As of September 2021,
Android Studio Arctic Fox has preliminary support for the M1 chip. This should
improve with time.

Language Experience

In general, to write Android apps, you need to know how to work with computer
programming languages. In particular, Android app development is focused heavily
on Java and Kotlin, with Groovy also playing a role.

Java

The original programming language used for Android app development was Java.
Right now, most Android code in the world is written in Java, and most educational
material is written around Java.

As a result, to be an Android app developer today, it helps to know Java.

This book does not teach you Java. Java has been around for around two decades,
and so there are lots of existing books, courses, videos, and the like to help you learn
Java. However, there are many things in Java that are not really relevant for Android
app development, such as Swing desktop GUIs and Java servlets for Web
applications. You do not need to know everything about Java, as Java is vast. Rather,
focus on:
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+ Language fundamentals (flow control, etc.)
+ Classes and objects

» Methods and data members

* Public, private, and protected

+ Static and instance scope

+ Exceptions
* Threads

» Collections
* Generics
« File /O
* Reflection
 Interfaces

The links are to Wikibooks material on those topics, though there are countless
other Java resources for you to consider.

Kotlin

The primary current language for Android app development is Kotlin. Kotlin is a
fairly new language, having only reached 1.0 status in 2016. That causes some
problems, as there is less material about how to write Kotlin than there is on how to
write Java. On the other hand, Kotlin adopts newer approaches and discards legacy
“cruft”. The resulting language can be much more concise, getting more work done
with fewer lines of code.

This book does not teach you Kotlin. The author of this book is also the author of
Elements of Kotlin, which was written with an eye towards it being a companion to
the book that you are reading now. From time to time, you will find this book
pointing out relevant chapters and sections in Elements of Kotlin, to help newcomers
to both Android and Kotlin learn both subjects.

Note that at the 2019 Google I|O conference, Google indicated that the Android SDK
will be “Kotlin first” going forward. While Java development is still possible, Google
will be focusing on Kotlin in terms of documentation, samples, education, and some
new technologies. So, while this book will present material in both Java and Kotlin,
you should strongly consider learning Kotlin in the not-too-distant future.

Groovy and Gradle

The code that causes your app to do stuff will be written mostly in Java and Kotlin.
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The code that causes your app to be built out of that Java and Kotlin will be written
in Groovy... though you may not notice this much.

Most Android apps are built using a build tool called Gradle. Gradle is a program for
building other programs. We will be working with “Gradle build scripts” to configure
how Gradle turns our source code into a (hopefully) working app. The Gradle build
scripts that we use today usually are written using the Groovy programming
language.

However, for most basic uses of Gradle — including pretty much everything in this
book — you will not need to think much about Groovy syntax. Just follow the
recipes described in the book, and you can put off learning Groovy until such time
as you really want to start creating elaborate build scripts.

An Android Test Environment
Writing Android apps is fun!
(no, really!)

However, that fun only appears when you can actually run the app that you created.
Otherwise, you just have a hunk of source code that sits around doing nothing. To
run the app, you will need an Android device or emulator.

Devices

Every Android developer should have at least one Android device. Every Android
device that legitimately has the Play Store on it is able to be used for app
development. You can enable the super-secret “developer options” in the device, to
allow you to install apps that you have written yourself on the device and test them
out — we will see how to do that in this book.

Typically, that Android device will be a phone, though you could test on something
else, such as a tablet, if you wish. Android app development puts few requirements
on the device itself; for example, you do not necessarily need to have a usable SIM
installed in the phone.

In an upcoming chapter, you will see how to configure your Android device for use
with app development.
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Emulators

All Android developers should have at least one device. Some Android developers,
such as the author of this book, have lots of Android devices. However, inevitably,
you run into cases where hardware is a problem:

* You want to test your app on different versions of Android, but you do not
have a device for a particular Android version

* You want to test your app for various screen sizes and resolutions, but you
do not have devices for all of the scenarios that you wish to test

* You want to test your app in unusual situations, such as running on a
Chromebook, and you do not have a device that matches

For those cases, the Android tools come with an emulator. The emulator gives you
an app for your development machine that pretends to be an Android device. You
decide what sort of device it is: Android version, screen size and resolution, and so
on. You can run your app on the emulator and get a sense for what it would be like
for the app to be running on a real device with those same characteristics.

In an upcoming chapter, you will see how to set up the Android emulator.

Patience and Serenity
Android app development often can be a frustrating experience:

* Advice that you get from older sources may not work, due to changes in
Android

* Dealing with multiple programming languages makes it more difficult to
make use of advice that you get, if you have to keep converting code snippets
between languages

* The GUI that you wrote that works fine on one device does not work quite as
well on the next device

* And so on

You will be able to address all of these challenges in time. Early on, though, you
should expect that these sorts of problems will arise, and you will need to cope with
them when they do.
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How This Book Is Organized

This book is divided into two major parts: a “Hello, World” walk-through and
“deeper dives” into major Android app development topics.

“Hello, World!”’, Front to Back

For decades, the classic first program for a person in a given programming
environment is dubbed “hello, world”.

In a typical programming environment, a “hello, world!” app is usually trivial,
offering little to learn from.

Android is complicated, which makes even “hello, world!” a place to learn all sorts of
things, from how user interfaces get constructed, to how our tools work, to how the
tools know how to build that app and show us that user interface.

So, in the first several chapters, we will examine various facets of a “hello, world!”
app generated from Android Studio’s new-project wizard.

Deeper Dives

Of course, a “hello, world!” app is very shallow. You will not get very far in Android
app development if all you know is what “hello, world!” shows you.

So, after the tour of the “hello, world!” app, we will expand upon the concepts seen
there, exploring different aspects of Android app development. We will not cover
everything in Android — that would take thousands upon thousands of pages. This
book will give you a basic foundation for Android app development and will help
point you to places to learn other facets of what Android apps can do.
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Setting Up the Tools

Now, let us get you set up with the pieces and parts necessary to build an Android
app.

NOTE: The instructions presented here are accurate as of the time of this writing.
However, the tools change rapidly, and so these instructions may be out of date by
the time you read this. Please refer to the Android Developers Web site for current
instructions, using this as a base guideline of what to expect.

But First, Some Notes About Android’s Emulator

As mentioned in the previous chapter, the Android tools include an emulator, a
piece of software that pretends to be an Android device. This is very useful for
development — not only does it mean you can get started on Android without a
device, but the emulator can help test device configurations that you do not own.

Emulators not only emulate Android itself, but also the CPU of the Android device.
Most Android devices have ARM CPUs... but it is likely that your development
machine has an x86 CPU. The emulator can emulate an ARM CPU when running on
your x86 CPU, but it is slow. Fortunately, the emulator can also emulate an Android
device that has an x86 CPU, and this runs much more quickly. You really want to be
able to use the x86 emulator.

However, to use the x86 emulator, you will need some additional software:

* Linux users need KVM

+ macOS and Windows users need the “Intel Hardware Accelerated Execution
Manager” (a.k.a., HAXM), which the Android Studio installer will attempt to
install for you
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And, the x86 emulator will only work for CPUs meeting certain requirements:

Development CPU .
0S Manufacturer CPU Requirements
macOS Intel any modern Mac should work
macOS Apple M1 unclear
Linux/ Intel support for Intel VT-x, Intel EM64T (Intel 64),
Windows and Execute Disable (XD) Bit functionality
support for AMD Virtualization (AMD-V) and
Linux AMD Supplemental Streaming SIMD Extensions 3
(SSSE3)
XVIrrilld;;Z; t)or AMD support for Windows Hypervisor Platform
P newer (WHPX) functionality

If your CPU does not meet those requirements, you will want to have one or more
Android devices available to you, so that you can test on hardware rather than the
emulator.

If you are running Windows or Linux, you need to ensure that your computer’s BIOS
is set up to support “virtualization extensions”. Unfortunately, many PC
manufacturers disable this by default. The details of how to get into your BIOS
settings will vary by PC, but usually it involves rebooting your computer and
pressing some function key on the initial boot screen. In the BIOS settings, you are
looking for references to “virtualization”. Enable them if they are not already
enabled. macOS machines come with virtualization extensions pre-enabled.

Part of the Android Studio installation process will try to set you up to be able to use
the x86 emulator. Make note of any messages that you see in the installation wizard
regarding “HAXM” (or, if you are running Linux, KVM), as those will be important
later.

Note that Apple M1 chip support is still a work in progress. While Android Studio
Arctic Fox appears to have M1 support, it also appears that this support is a bit rough
in spots. Hopefully, this will smooth out with future versions of Android Studio.
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Step #1: Install Android Studio

At the time of this writing, the current production version of Android Studio is
2020.3.1 Arctic Fox and this book covers that version. Android Studio gets updated
often, and so you may be on a newer version — there may be some differences
between what you have and what is presented here.

You have two major download options. You can get the latest shipping version of
Android Studio from the Android Studio download page. Or, you can download
Android Studio Arctic Fox directly, for:

* Windows
* macOS x86
* macOS M1
* Linux

Windows users can download a self-installing EXE, which will add suitable launch
options for you to be able to start the IDE.

Mac x86 users can download a DMG disk image and install it akin to other Mac
software, dragging the Android Studio icon into the Applications folder. M1 users get
a ZIP file instead.

Linux users can download a ZIP file, then unZIP it to some likely spot on your hard
drive. Android Studio can then be run from the studio batch file or shell script in
your Android Studio installation’s bin/ directory.
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Step #2: Running Android Studio for the First Time

When you first run Android Studio, you may be asked if you want to import settings
from some other prior installation of Android Studio:

Import Android Studio Settings From... X

Config or installation Folder:

® Do notimport settings
OK
Figure 1: Android Studio First-Run Settings Migration Dialog

If you are using Android Studio for the first time, the “Do not import settings”
option is the correct choice to make.

10
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Then, after a short splash screen, you may be presented with a “Data Sharing”
dialog:

Data Sharing x

Allow Google to collect anonymous usage data for Android Studio and its related tools—
such as how you use features and resources, and how you configure plugins. This data
helps improve Android Studio and is collected in accordance with Coogle's Privacy Policy.

Data sharing preferences apply to all installed Google products.

You can always change this behavior in Settings | Appearance & Behavior | System Settings | Data Sharing.

Send usage statistics to Google Don'tsend

Figure 2: Android Studio Data Sharing Dialog

Click whichever button you wish.

11
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Eventually, you will be taken to the Android Studio Setup Wizard:

Android Studio Setup Wizard

£ welcome

H Android Studio

Welcome! This wizard will set up your development environment For Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studio
or create a new Android application project.

MO ImE

Previo m Cancel Finish
Figure 3: Android Studio Setup Wizard, First Page

12
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Just click “Next” to advance to the second page of the wizard:

Android Studio Setup Wizard

"'(' Install Type

Choose the type of setup you want For Android Studio:

© standard
Android Studio will be installed with the most common settings and options.
Recommended for most users.

() Custom
You can customize installation settings and components installed.

Previo... m Cancel Finish
Figure 4: Android Studio Setup Wizard, Second Page

Here, you have a choice between “Standard” and “Custom” setup modes. Most likely,
right now, the “Standard” route will be fine for your environment.

13
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If you go the “Standard” route and click “Next”, you should be taken to a wizard page
where you can choose your Ul theme:

Android Studio Setup Wizard

H Select Ul Theme

() Darcula © Light
= module src ' (€7 HelloWorld
¢ Helloworld.java
import javax.swing.;

import javax.awt.*;

public class HelloWorld {
public Helloworld() {
rame rame | ® JFrame frame = new JFrame (“Hello wt

1 labe JLabel(); JLabel label = new JLabel(]);
label.setFont(new Font("Serif", Fom

Breakpoints

Breakpoints label

Trame

Trameg 4 @] (€]
frame

frame ® Line Breakpoints

frame v Line 6 in Helloworld.He|

n Helloworld.Hel

Previo... m Cancel Fin
Figure 5: Android Studio Setup Wizard, Ul Theme Page
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Choose whichever you like, then click “Next”, to go to a wizard page to verify what
will be downloaded and installed:

Android Studio Setup Wizard

Verify Settings

IF you want to review or change any of your installation settings, click Previous.

Current Settings:

Android SDK Build-Tools 29.0.3 51.3MB
Android SDK Platform 29 74.6 MB
Android SDK Platform-Tools 8.96 MB
Android SDK Tools 147 MB
SDK Patch Applier v4 1.74 MB
Sources for Android 29 37.6 MB

Previo... m Cancel Finish
Figure 6: Android Studio Setup Wizard, Verify Settings Page
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Clicking “Next” may take you to a wizard page explaining some information about
the Android emulator:

Android Studio Setup Wizard

Q Emulator Settings

We have detected that your system can run the Android emulator in an accelerated performance mode.

Linux-based systems support virtual machine acceleration through the KVM (Kernel-based Virtual
Machine) software package.

Follow Configure hardware acceleration for the Android Emulator to enable KVM and achieve better
performance.

Previo... Next Cancel m
Figure 7: Android Studio Setup Wizard, Emulator Info Page

What is explained on this page may not make much sense to you. That is perfectly
normal, and we will get into what this page is trying to say later in the book. Just
click “Finish” to begin the setup process. This will include downloading a copy of the

Android SDK and installing it into a directory adjacent to where Android Studio
itself is installed.

When that is done, Android Studio will busily start downloading stuff to your
development machine.

16
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Clicking “Finish” when that is done will then take you to the Android Studio
Welcome dialog:

Welcome to Android Studio - o x
" Android Studio
Arctic Fox | 2020.3.1
Projects
. .
e Welcome to Android Studio
Plugins Create a new project to start from scratch.
Learn Android Studio Open existing project from disk or version control.
Pi p
New Project Open Get from VCS
More Actions ~

o

Figure 8: Android Studio Arctic Fox Welcome Dialog

17
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Getting Your First Project

Creating an Android application first involves an Android “project”. As with many
other development environments, the project is where your source code and other
assets (such as icons) reside. And, the project contains the instructions for your tools
for how to convert that source code and other assets into an Android app.

So, let’s work on setting up a “hello, world!” application to examine.

As with the rest of this book, these instructions are for Android Studio Arctic Fox. If
you are using a different version of this IDE, while the instructions are likely to be
close to what you will see, there will be differences.

Step #1: Importing the Project

Roughly speaking, there are two ways to start with a project with Android Studio:
creating a new project or importing an existing project.

It might sound like creating a new project would be the more common scenario. In
truth, many developers import an existing project, because they are working on a
development team, and somebody else on the team created the project. Often, that
project was created quite some time ago, with developers coming and going from
the team.

So, while we will see how to create a project later in the book, for now, let’s import
an existing project, one set up for use by this book. It will closely resemble the sort
of project that you get when creating a brand-new project in Android Studio.

You can download this project from the CommonsWare site. Then, unZIP that
project to some place on your development machine. It will unZIP into an

19
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HelloWorld/ directory.

Then, import the project. From the Android Studio welcome dialog — where we
ended up at the end of the previous chapter — you can import a project via the
“Import project (Eclipse ADT, Gradle, etc.)” option. If you already have a project
open in Android Studio, you can import a project via File > New > Import Project...
from the main menu.

Importing a project brings up a typical directory-picker dialog. Pick the HelloWorld/
directory and click OK to begin the import process. This may take a while,
depending on the speed of your development machine. A “Tip of the Day” dialog
may appear, which you can dismiss.

At this point, you should have a mostly-empty Android Studio IDE window:

Helloworld [/tmp/Helloworld] - Android Studio - o @
File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
=B S Y app v || (:5.0WXGA ~ | » k-3 & 5 oML BQ
HelloWorld
B Android ~ S % - -
[}
R
=i|* @ Cradle Scripts 5
)
@
g
g
=
8
3
E Search Everywhere Double Shift
= Go to File Ctrl+Shift+N
2 RecentFiles Ctri+E
g
% Navigation Bar Ali+Home
Gl Drop files here to open
0
2
©
z
i
&i| Build:  Build Output Sync T —
* - i e

e SR T
“ > Task :app:generateDebugBuildConfig UP-TO-DATE
> Task :app:prepareLintJar UP-TO-DATE

> Task :app:prepareLintJarForPublish UP-TO-DATE
> Task :app:compileDebugAidl NO-SOURCE

> Task :app:compileDebugRenderscript NO-SOURCE
> Task :app:generateDebugSources UP-TO-DATE

a2

K Build Variants

BUILD SUCCESSFUL in ©s
4 actionable tasks: 4 up-to-date

1210/dx3 3)14 a01maq

= e Yl

btures

:=TODO cs CheckStyle ™ Terminal & 4 Build = 6: Logcat Q Event Log
1D Gradle build finished in 322 ms (moments ago) [ 368 of 1981M

Figure 9: Android Studio Project Window, Showing Hello World

We will examine what is all in this window coming up in future chapters. But, first,
let’s get things set up for you to be able to run this sample app and see its results.
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Step #2: Get Ready for the x86 Emulator

Your next decision to make is whether or not you want to bother setting up an
emulator image right now. If you have an Android device, you may prefer to start
testing your app on it, and come back to set up the emulator at a later point. In that
case, skip to Step #4.

Also, this book does not cover the Apple M1 CPU — you will need to determine what
the current instructions are for getting a working emulator in that environment.

Otherwise, here is what you may need to do, based on the operating system on your
development machine.

Windows

If your CPU met the requirements, and you successfully enabled the right things in
your system’s BIOS, the Android Studio installation should have installed HAXM,
and you should be ready to continue with the next step.

If, on the other hand, you got some error messages in the installation wizard
regarding HAXM, you would need to address those first. Unfortunately, there is so
much variety in PC hardware and possible problems that this book cannot help you
diagnose and fix your HAXM problem:s.

Mac

The wizards of Cupertino set up their Mac hardware to be able to run the Android
x86 emulator without additional configuration. This is really nice of them,
considering that Android competes with iOS. The Android Studio installation
wizard should have installed HAXM successfully, and you should be able to continue

with the next step.
Linux

The Android x86 emulator on Linux does not use HAXM. Instead, it uses KVM, a
common Linux virtualization engine.

If, during the Android Studio installation process, the wizard showed you a page
that said that you needed to configure KVM, you will need to do that before you can
set up and use the x86 emulator. The details of how to set up KVM will vary by
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Linux distro (e.g., Ubuntu).

Step #3: Set Up the AVD

The Android emulator can emulate one or several Android devices. Each
configuration you want is stored in an “Android virtual device”, or AVD. The AVD
Manager is where you create these AVDs.

To open the AVD Manager in Android Studio, choose Tools > AVD Manager from the
main menu.

You should be taken to “welcome”-type screen:

Android Virtual Device Manager

"% vour Virtual Devices

H Android Studio

o[ ]mE

Virtual devices allow you to test your application
without having to own the physical devices.

+ Create Virtual Device...

To prioritize which devices to test your application
on, visit the Android Dashboards, where you can get
up-to-date information on which devices are active
in the Android and Google Play ecosystem.

Figure 10: Android Studio AVD Manager, Welcome Screen
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Click the “Create Virtual Device” button, which brings up a “Virtual Device
Configuration” wizard:

Virtual Device Configuration

Select Hardware

H Android Studio

Choose a device definition

- [j Nexus 4
Category Name ~ PlaysStore| sSize |Resoluti...| Density
v Nexus 6P 57" 1440%...  560dpi
) 768px
Nexus 6 5.96 1440x%...  560dpi Size:  normal
Ratio:  long _
Wear 0OS Nexus 5% E- 5.2" 1080x...  420dpi Density: xhdpi
a7 J1280px
Tablet Nexus 5 5" 1080x... xxhdpi
.
Galaxy Nexus 5" 720x1...  xhdpi
8" Foldable 8.03" 2200%... 420dpi
New Hardware Profile Import Hardware Profiles S Clone Device...
‘ Previous m cancel Finish Help

Figure 11: Android Studio Virtual Device Configuration Wizard, First Page

The first page of the wizard allows you to choose a device profile to use as a starting
point for your AVD. The “New Hardware Profile” button allows you to define new
profiles, if there is no existing profile that meets your needs.

Since emulator speeds are tied somewhat to the resolution of their (virtual) screens,
you generally aim for a device profile that is on the low end but is not completely
ridiculous. For example, a 1280x768 or 1280x720 phone would be considered by
many people to be fairly low-resolution. However, there are plenty of devices out
there at that resolution (or lower), and it makes for a reasonable starting emulator.

If you want to create a new device profile based on an existing one — to change a
few parameters but otherwise use what the original profile had — click the “Clone
Device” button once you have selected your starter profile.

However, in general, at the outset, using an existing profile is perfectly fine. The
Nexus 4 image is a likely choice to start with.
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GETTING YOUR FIRST PROJECT

Clicking “Next” allows you to choose an emulator image to use:

Virtual Device Configuration

System Image

H Android Studio

Select a system image

Recommended  x86Images  Other Images

Pie

Release Name APl Level ~ ABI Target
Q Download Android 9.+ (Google AP.’S) AP Level
_—— 20
Oreo Android 8.1 (Google APIS) Android
Oreo Download 26 x86 Android 8.0 (Google APIs) 9.0
Nougat Download 25 X86 Android 7.1.1 (Google AP Google Inc.
Nougat 24 x86 Android 7.0 (Google APIs) System Image
Marshmaliow Download | 23 86 Android 6.0 (Google APIs) x86
Lollipop Download 22 x86 Android 5.1 (Google APIs)

We recommend these images because they
run the fastest and suppori Google APls.

Questions on API level?
See the AP level distribution chart

[4]

Previous Next Cancel Finish Help

Figure 12: Android Studio Virtual Device Configuration Wizard, Second Page

The emulator images are spread across three tabs:

+ “Recommended”
+ “x86 Images”
+ “Other Images”

Each of those tabs lists a bunch of possible emulator images, where those tables
have cryptic columns like “API Level” and “Release Name”. We will get into what
those are a bit later in the book. For right now, the key column is the “Target”
column. This will tell you what version of Android the emulator emulates, such as
“Android 8.1” or “Android 5.1". For the time being, whether the “Target” has “(Google
APIs)” or not does not matter very much.
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GETTING YOUR FIRST PROJECT

On some of these tabs, you should see some entries with a “Download” link, and you
might see others without it. The emulator images with “Download” next to them
will trigger a one-time download of the files necessary to create AVDs for that
particular API level and CPU architecture combination, after another license dialog
and progress dialog:

SDK Quickfix Installation

Component Installer

H) Android Studio

! Installing Requested Components

| SDKPath: fhome/mmurphy/Android/sdk

| Packages to install:
- Intel x86 Atom System Image (system-images;android-28;default;x86)

Preparing "Install Intel x86 Atom System Image (revision: 4)".
Downloading https://dl.google.com/android/repository/sys-img/android/x86-28 r04.zip

| Downloading (6%): 25.0 / 417.1 MB ...
| https://dl.google.com/android/repository/sys-img/android/x86-28_r04.zip

i @ Please wait until the installation finishes
Previous Next Cancel Finish

Figure 13: Android Studio Component Installer Dialog, Downloading API 28 Image
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Once you have identified the image that you want — and have downloaded it if
needed — click on one of them in the wizard. Clicking “Next” allows you to finalize
the configuration of your AVD:

Virtual Device Configuration

£ Android Virtual Device (AVD)

,‘&7 Android Studio

Verify Configuration
AVD Name | Nexus 4 API 28 AVD Name

(D) Nexus4 4.7 768x1280 xhdpi The name of this AVD.
i Pie Android 9.0 x86
Startup orientation — l ‘

Portrait Landscape

Emulated .. =
Performance Graphics:  Automatic n

Show Advanced Settings |

Figure 14: Android Studio Virtual Device Configuration Wizard, Third Page

A default name for the AVD is suggested, though you are welcome to replace this
with your own value. However, that name must be something valid: only letters,
numbers, spaces, and select punctuation (e.g., ., _, -, (, )) are supported.

The rest of the default values should be fine for now.

Clicking “Finish” will return you to the main AVD Manager, showing your new AVD.
You can then close the AVD Manager window.

Step #4: Set Up the Device

You do not need an Android device to get started in Android application
development. Having one is a good idea before you try to ship an application (e.g.,
upload it to the Play Store). And, perhaps you already have a device — maybe that is
what is spurring your interest in developing for Android.
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GETTING YOUR FIRST PROJECT

If you do not have an Android device that you wish to set up for development, you
can skip this step and jump ahead to Step #s.

First, we need to enable USB debugging on the device. To do this, go into the
Settings app.

You will need to find the “Build number” entry in here. Normally, that is on an
“About” screen in Settings, though some devices have it in a separate screen (e.g.,
“Software Info”) off of the “About” screen.

Once you find the “Build number” entry, tap it seven times.

(yes, this is silly — just roll with it)

You should then see a brief popup message (a Toast) indicating that you are now a
developer.

Then, you should have access to a “Developer options” item. Once again, the exact
location of this varies by device, but usually it is either:
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* An entry on the main Settings screen
* An entry in “System” > “Advanced options”, particularly on Android 8.0+
devices:

10:13 P v

& System aQ @

@ About phone
Pixel

@ Languages & input
Gboard

DZ Gestures

@ Date & time
GMT-04:00 Eastern Daylight Time

Backup
& off

o) Reset options
Network, apps, or device can be reset

Multiple users
Signed in as Mark

{} Developer options €

System update
= Updated to Android 9

Figure 15: System Screen in Android 9.0 Settings App, Showing Advanced Options,
with Developer Options Highlighted
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Tapping on “Developer options” will bring up the Developer Options screen:

10:14

e

P v

Developer options Q

Memory
Avg 1.8 GB of 3.9 GB memory used

Take bug report

Desktop backup password
Desktop full backups aren't currently protected

Stay awake .
Screen will never sleep while charging

Enable Bluetooth HCI snoop log

Capture all Bluetooth HCI packets in a
file (Toggle Bluetooth after changing this
setting)

Running services
View and control currently running services

4 ® |

Figure 16: Developer Options Screen in Android 9.0 Settings App

You may need to slide a switch in the upper-right corner of the screen to the “ON”
position to modify the values on this screen.

Published under the Creative Commons
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Then, scroll down and enable USB debugging, so you can use your device with the

Android build tools:

10:15 P B v

e

Developer options Q

Debugging

USB debugging '
Debug mode when USB is connected

Revoke USB debugging authorizations

Bug report shortcut
Show a button in the power menu for
taking a bug report

Select mock location app
No mock location app set

Force full GNSS measurements
Track all GNSS constellations and
frequencies with no duty cycling

Enable view attribute inspection

Select debug app

N dohin annlicatinn cot

4 ® |

Figure 17: Debugging Options, in Android g.o Settings App

You can leave the other settings alone for now if you wish, though you may find the
“Stay awake” option to be handy, as it saves you from having to unlock your phone
all of the time while it is plugged into USB.

Published under the Creative Commons
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On devices running Android 4.2.2 or higher, before you can actually use the setting
you just toggled, you will be prompted to allow USB debugging with your specific
development machine via a dialog box:

Allow USB debugging?

The computer's RSA key fingerprint is:
e & i N "N i
o |

D Always allow from this computer

Cancel OK

Figure 18: Allow USB Debugging Dialog

This occurs when you plug in the device via the USB cable and have the driver
appropriately set up. That process varies by the operating system of your
development machine, as is covered in the following sections.

Windows
When you first plug in your Android device, Windows will attempt to find a driver
for it. It is possible that, by virtue of other software you have installed, that the

driver is ready for use. If it finds a driver, you are probably ready to go.

If the driver is not found, you can try to get one from the manufacturer links on the
Android Developer site.

macOS and Linux

It is likely that simply plugging in your device will “just work”.
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If you are running Ubuntu (or perhaps other Linux variants), and when you later try
running your app it appears that Android Studio does not “see” your device, you may
need to add some udev rules. This GitHub repository contains some instructions and
a large file showing the rules for devices from a variety of manufacturers, and this
blog post provides more details of how to work with udev rules for Android devices.

Step #5: Running the Project

Now, we can confirm that our project is set up properly by running it on a device or
emulator.

Android Studio has a toolbar just below the main menu. In that toolbar, you will
find two drop-down lists, followed by the Run toolbar button (usually depicted as a
green rightward-pointing triangle):

N app - C1I0WXGA = b = 3
Figure 19: Android Studio Toolbar Segment

The first drop-down says “this is what [ want to run”. Right now, your only viable
option is “app’, referring to the app that this project builds.

The second drop-down says “this is where [ want to run it”. Here, you will find a list
of devices and emulators that are available to you.
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To run the app, choose your desired device or emulator in the second drop-down,
then click the Run toolbar button. If you choose an emulator, and the emulator is
not already running, Android Studio will start it up. Then, after a short wait, your
app should appear on it:

1022 &

Hello World

Figure 20: Android 9.0 Emulator with HelloWorld App

Note that you may have to unlock your device or emulator to actually see the app
running.

The first time you launch the emulator for a particular AVD, you may see this
message:

Cold boot: snapshot

doesn't exist

Figure 21: Android Emulator Cold-Boot Warning

The emulator behaves a bit like an Android device. Closing the emulator window is
more like tapping the POWER button to turn off the screen. The next time you start
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that particular AVD, it will wake up to the state in which you left it, rather than
booting from scratch (“cold boot”). This speeds up starting the emulator.
Occasionally, though, you will have the need to start the emulator as if the device
were powering on. To do that, in the AVD Manager, in the drop-down menu in the
Actions column, choose “Cold Boot Now”.

Actions
7
7
Y
> 7
7
7

a|peIS

Dupiicate
Wipe Data
Cold Boot Now
Show on Disk
View Details
Delete

100

Figure 22: AVD Manager, Showing Actions Drop-Down Menu
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Taking a Tour of Android Studio

At this point, you have Android Studio set up, you have imported a project, and you
have run that app on a device or emulator. Congratulations!

However, it may be useful for you to understand exactly what all of this does.

So, in this chapter and the next few that follow it, we are going to walk through what
you set up in the previous two chapters, to explain what the pieces are and how they
work together. We will start by examining Android Studio itself and the major things
that you will be using.
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The Project Tree

The “Project” view — docked by default on the left side, towards the top — brings
up a way for you to view what is in the project.

File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

= H S| « “~ app ~ | 0, Google Pixel 4 ~ | » E- o % ML mBQ

= HelloWorld app

;EL Android ~ @ = @ — & activity mainxml & MainActivity. kt -~

bk . v 0

g 1 package com.commonsware.jetpack.hello 8

i » @ Gradle Scripts - @

- 2

& 3 import ...

g 5

g 5

§ 6 mm class MainActivity : AppCompatActivity() {

: 7

% g of override fun onCreate(savedInstanceState: Bundle?) {

9 super.onCreate(savedInstanceState)

© A . . .

3 10 setContentView(R.layout.activity main)

& 11 }

: 12 +

3

g 13

o

g

= [}
H
8

2 7

8

5 £

= =)

= H

[

:=TODO cs CheckStyle = 6:Logcat < Build @ Terminal Q Event Log
10 Gradle sync finished in 296 ms (from cached st... (a minute ago) 1:1 LF UTF-8 2spaces & 8520f 1981M

Figure 23: Android Studio Project View (Highlighted with Red Arrow)

What appears in this view is determined by the drop-down list above the tree itself:

- HelloWorld app
Android « = O —

& Gradle Scripts

¥ 1: Project ‘

Figure 24: Android Studio Project View Drop-Down (Highlighted with Red Arrow)
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The default is known as the “Android view”:

- HelloWorld app src main = w Andn
Android + D= & —

app
i AndroidManifest.xml
java
com.commonsware.jetpack.hello
com.commonsware.jetpack.hello (ant
com.commonsware.jetpack.hello (tes
res
drawable
layout
mipmap
values
@ Gradle Scripts
build.gradle (Project: My Application)
build.gradle (Module: app)
nigradle.properties (Global Properties)
n1gradle-wrapper.properties (Gradle Versi
= proguard-rules.pro (ProGuard Rules for
nigradle.properties (Project Properties)
settings.gradle (Project Settings)
tilocal.properties (SDK Location)

Figure 25: Android Studio Project View, “Android” Mode

% Resource Manager | I 1: Project

T: Structure

Al Layout Captures
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You are welcome to use this if you wish. Many newcomers to Android are more
comfortable changing that drop-down to be “Project”. This converts the tree to one
showing the files that make up the project, with a typical sort of directories-and-files
structure:

Project ~ [34]
HelloWorld
.gradle
idea
app
libs
| vesc |
androidTest
main
java
com.commonsware.jetpack.hello
res
drawable
drawable-v24
layout
mipmap-anydpi-v26
mipmap-hdpi
mipmap-mdpi
mipmap-xhdpi
mipmap-xxhdpi
mipmap-xxxhdpi
values
# AndroidManifest.xml
test
» .gitignore
build.gradle
= proguard-rules.pro

Figure 26: Android Studio Project View, “Project” Mode

M
&

I 1: Project

s Resource Manager

5 1@ Structure

K Build variants

avorites

This book usually will show the “Project” edition of the tree.

38

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



TAKING A TOUR OF ANDROID STUDIO

The Editing Pane

The biggest area of the IDE is devoted to the editing pane. Most files that you
double-click on in the Project view will open in the editing pane. Each such file gets
its own tab:

Helloworld [/tmp/HelloWorld] - .../app/src/main fjava/com fcommonsware fjetpack/hello/MainActivity.kt [app] - Android Studio - o @
File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
=H S|« A [=app | L5.0WXGA ~| » G S moLe moaQ
HelloWorld app sIc main java com commonsware jetpack hello - & MainActivity.kt
g Android ~ © = & — & MainActivity.kt -
2 app package com.commonsware. jetpack.hello 1§
ey manifests : - : 2
7 java o
_ java (generated)
5 o import ...
é # Gradle Scripts . o o
3 build.gradle (Project: Hello World) s class MainActivity : AppCompatActivity() {
g build.gradle (Module: app)
14} ies (G
o :gﬁﬁ:ﬁgﬁﬂf;@e of override fun onCreate(savedInstanceState: Bundle?) {

super.onCreate(savedInstanceState)
setContentView(R.layout.activity main)

£ proguard-rules.pro (P
11gradle.properties (Proj
settings.gradle (Proje

. 7: Structure

] 11local.properties (SDK Location } }'

@

£

s

H

&

&

*

2

5 0

= @

3 ul
@

-
g
k=1

@ 5

@ °

5 &

i=TODO ¢s CheckStyle EATerminal “ Build = 6: Logcat Q Event Log
[0 Gradle build finished in 297 ms (3 minutes ago) 425 LF: UTF-8: 2spaces: m & 286 of 1581M

Figure 27: Android Studio Project View, Showing Editing Pane

The Docked Views

The “Project” view is not the only such view docked along the edges of the IDE. A
variety of other such views are docked there by default, and the View > Tool
Windows menu will offer other such views that you can display.
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Some of these are “general purpose”, not strictly tied to Android app development.
For example, the “Terminal” tool, docked by default towards the bottom of the IDE,
brings up a terminal or command prompt, so you can execute command-line
programs right from within the IDE:

Terminal

+ mmurphy@E6530:/tmp/HelloWorld 1s
app build.gradle gradle.properties gradlew.bat local.properties
build gradle gradlew HelloWorld.iml settings.gradle

mmurphy@E6530: /tmp/HelloWorld I

[# Terminal W“Build = 6:Logcat s Profiler P 4:Run 5 TODO

Figure 28: Android Studio Terminal

Others of these, such as “Gradle” and “Logcat’, are tied to Android app development,
and we will examine those in greater detail as we explore different aspects of how to
write Android apps.

Popular Menu and Toolbar Options

Across the top of the IDE are toolbars. These represent a subset of the items that are
available in the IDE’s main menu. There are lots of toolbar options and lots of menu
items. We will use some of these in the course of this book, but we will not be
examining all of them.

By contrast, there are several menu items — many with corresponding toolbar
buttons — that are fairly popular and are worth mentioning now.

We already used one of these toolbar buttons: the Run option, represented by a
green triangle:

N app - C1I0WXGA = b = 3
Figure 29: Android Studio Toolbar Segment

40

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



TAKING A TOUR OF ANDROID STUDIO

Additional Run Options

After you have run your app on a device or emulator, a few new toolbar buttons will
show up, replacing the original Run button:

.app ~ ,Google Pixel2 ~ @& ¢ =
Figure 30: Post-Run Android Studio Toolbar Segment

The black square with a green curved arrow will re-run your app on the device or
emulator. This will do the same thing as the Run button did back when it was just
the simple green triangle.

The “A” with a green curved arrow, and the four lines with a tiny green curved arrow,
will try to take changes that you have made in the IDE and simply “apply” them to
the running copy of your app. For larger projects, this might be substantially faster
than just running the app. However, it is somewhat risky — the resulting patched
app might not be exactly the same as what you would get by just running it
normally.

Debug

Near to those toolbar buttons is a large green bug:

,Google Pixel2 ~ | » & E ﬁh-

Figure 31: Android Studio Debug Toolbar Button (Highlighted with Red Arrow)

This is the “Debug” button. By default, clicking this has much the same effect as
clicking the Run button, other than Debug happening a bit more slowly. However,
this runs your app under the control of the Android Studio debugger, where you can
set breakpoints, inspect objects, and otherwise see what is going on when the app is
running.

We will examine how to use the Android Studio debugger more later in the book.

Open Project/Open Recent

In Android Studio, you can have several projects open at one time. Each project gets
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its own separate window, with the same menus, toolbar, and so on as do the other
windows.

To open another project, you can:

+ Choose File > Open... from the main menu, to open an existing Android
Studio project

* Choose File > Open Recent from the main menu, which will bring up a fly-
out menu containing a list of projects that you have recently worked on, to
be able to re-open those projects rapidly

* Choose File > New > Import Project from the main menu to import another
project and set it up for use with Android Studio

* Choose File > New > New Project from the main menu to create a new
project using a new-project wizard, which we will examine later in the book

To stop working on a project, just close its window. To stop Android Studio
completely, close all of its windows. When you re-launch Android Studio, it will re-

open the last project you had worked in, and you can get to other recent projects
quickly via File > Open Recent.

AVD Manager
We saw how to set up an emulator with the AVD Manager in the previous chapter.
To return to the AVD Manager, you can use the Tools > AVD Manager main menu

option that you did before. Also, there is a toolbar button for more rapid access to
the AVD Manager:

AL s
[ e Actiity _main.xr
activity! main.xmi

Figure 32: Android Studio AVD Manager Toolbar Button (Highlighted with Red
Arrow)

We will explore the AVD Manager, and working with the emulator, in greater detail
in an upcoming chapter.
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SDK Manager

When you installed Android Studio and ran it for the first time, a lot of the tools,
libraries, and related materials that form “the Android SDK” were also downloaded
and installed for you.

When updates to Android Studio or installed pieces of the Android SDK are
available, you will be prompted with a dialog or other form of pop-up, where you
can elect to allow Android Studio to install the update. Note that installing updates
may take a few minutes, depending on your Internet connection speed. Also note
that installing updates may require you to restart Android Studio afterwards to apply
those updates.

On occasion, you may find instructions telling you to go to “the SDK Manager” to

install something. You can get to the SDK Manager via Tools > SDK Manager in the
main menu or via its corresponding toolbar button:

B AL B
[ ' & activity fnain.xr
activity_maingxmi

Figure 33: Android Studio SDK Manager Toolbar Button (Highlighted with Red
Arrow)

We will explore the SDK Manager in greater detail later in the book.
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Settings

To control the overall behavior of Android Studio, there is a Settings dialog that you
can display via “File” > “Settings” (on Windows and Linux; macOS has an equivalent
option in “Android Studio” > “Preferences...”):

Build, Execution, Deployment

Appearance & Behavior Configure the project Execution settings, set up Deployment options and customize the Debugger
Keymap behavior.
Editor Gradle
Plugins Debugger
Version Control Remote Jar Repositories
Compiler
Gradle Deployment
Debugger Espresso Test Recorder
Remote Jar Repositories Required Plugins
Compiler
Coverage
Deployment

Espresso Test Recorder
Required Plugins
Languages & Frameworks
Tools
Other Settings
Experimental

m Cancel Help
Figure 34: Android Studio Settings Dialog

There are a lot of settings that you can configure in the Settings dialog. You can
either navigate via the tree on the left or via the search field.

Some popular things to tailor include:
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» The color scheme to use for the IDE:

Editor * Color Scheme : General

Appearance & Behavior Scheme: | Darcula - w
Keymap
Editor Code
General Editor
Font Errors _and Warnings
Hyperlinks

LIS Line Coverage

Popups and Hints

Language Defaults Search Results
Color Scheme Font Templates
Console Font Tt

Console Colors

with a high level of usability and outstanding
advanced code editing and refactoring support.

Custom
Debugger
Diff & Merge 4

VCS abcdefghijklmnopgrstuvwxyz 0123456789 (){}[]
CIC++ ABCDEFGHIJKLMNOPQRSTUVWXYZ +-*/= .,;:!7? #§
Java

Android Logcat
EditorConfig

m Cancel Apply Help
Figure 35: Android Studio Settings Dialog, Color Scheme General Settings
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*+ The font and font size to use in the editing pane:

Editor » Color Scheme : Color Scheme Font

Appearance & Behavior Scheme: Darcula v 3
Keymap
Editor ["] Use color scheme font instead of the default (Deja\Vu Sans Mono.22)

General

Font: DejaVu Sans Mono
Font
Color Scheme Size: 22
General Line spacing: |1.0

Language Defaults
Fallback font: | <None> For symbols not supported by the main font
Console Font
Console Colors
Custom i

Debugger abcdefghijklmnopgrstuvwxyz 0123456789 (){}[]

Szf:"‘"e’ge ABCDEFGHIJKLMNOPQRSTUVWXYZ +-*/= .,;::1? #&

CIC++

Java

Android Logcat
EditorConfig

m Cancel Apply Help
Figure 36: Android Studio Settings Dialog, Color Scheme Font Settings
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*+ The coding style rules to apply to your source code, for languages like Java
and Kotlin:

Settings o
Editor » Code Style » Kotlin
AppEdidiice o DELAYIUE Scheme: | Default IDE - @
Keymap Setfrom...
(=il Tabs and Indents  Spaces Wrapping and Braces  Blank Lines Imports Other Code Generation Load/Save
General Hard wrap at Default: 100 @Deprecated("Foo™)
Code Editin Wrap on typin Default: No . .
— 4 Visu‘;. g,_.tiﬂisg Default: None public class ThisIsASampleClass : C
Keep when reformatting val test =
Color Scheme Line breaks 12
Code Style Comrm_am at first colu_mn
3 Extendsfimplements list Do not wrap
aua Align when multiline n "
CIC++ Use continuation indent @DEDrecat?d{ Foo™) . .
CMak Function declaration parameters Do not wrap fun fool(il: Int, i2: Int, 13:
ake Align when multiline when (11) {
EditorConfig New line after '(' is Numb 0
Groovy Place ')’ on new line S Number -=
Use continuation indent else > 1
HTML Function call arguments Do not wrap }
JSON Align when muliiline .
= New line after '(' if ( i2 > 0 &&
Kotlin Place ')’ on new line i3 <0) {
Properties Use continuation indent
Shell Script Function parentheses return 2
el serp Align when multiline }
XML Chained function calls Do not wrap
Wrap first call return 0
YAML SR
§ Use continuation indent }
Other File Types 'if()' statement
Inspections ‘else’ on new line .
= Place ) on new line private fun foo2(): Int {
(10 FE EFED VT A Use continuation indent in conditions // +adn-+ camathina
? m Cancel Apply

Figure 37: Android Studio Settings Dialog, Kotlin Code Style Settings

We will explore more options later in the book.

Android Studio and Release Channels

When you install Android Studio for the first time, your installation will be set up to
get updates on the “stable” release channel. Here, a “release channel” is a specific set
of possible upgrades. The “stable” release channel means that you are getting full
production-ready updates. Android Studio will check for updates when launched,
and you can manually check for updates via the main menu (e.g., Help > Check for
Update... on Windows and Linux).

If an update is available, you will be presented with a dialog box showing you details
of the update, allowing you to view release notes, and encouraging you to apply the
update. If you choose the latter, the dialog downloads the update and restarts the
IDE, applying the update along the way.

47

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



TAKING A TOUR OF ANDROID STUDIO

To control which channel’s worth of updates you are getting, go to the Settings
dialog, and in there go to “Appearance & Behavior > System Settings > Updates™

Settings 0
Appearance & Behavior » System Settings @ Updates
- Appearance & Behavior Automatically check updates for = Stable Channel - Check Now
Appearance
Menus and Toolbars Last checked Yesterday 6:14 PM
- System Settings Current version Android Studio 4.2.1
Passwords Build number Al-202.7660.26.42.7351085
HTTP Proxy
Data Sharing
Date Formats
Android SDK
Memory Settings
File Colors
Scopes
Notifications
Quick Lists
Path Variables
Keymap
Editor
Plugins

View/edit ignored updates

Version Control
Build, Execution, Deployment

Languages & Frameworks

Tanls

? m Cancel
Figure 38: Android Studio Settings Dialog, Updates Screen

You have four channels to choose from:

Stable, which is appropriate for most developers

* Beta, which will get updates that are slightly ahead of stable

* Dev, which is even more ahead than is the beta channel

Canary, which is updated very early (and the name, suggestive of a “canary in
a coal mine”, indicates that you are here to help debug the IDE)

For most developers, Stable is the best choice. Power users might consider one of the
other channels.

48

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



TAKING A TOUR OF ANDROID STUDIO

When an update is available, Android Studio will tell you via a dialog:

IDE and Plugin Updates [ }
The latest stable release of Android Studio is now available for download.

Android Studio 4.2 is a major new release and includes performance improvements, bug fixes
and new features.

¢ IntelliJ 2020.2.3 Platform Update

* Safe Args Support

* New Project Wizard and Module Wizard Updates
¢ Database Inspector Improvements

* Retrace Command Line Tool

* AGP Upgrade Assistant

* Apply Changes Enhancements

* Multiple Device Deployment

* System Trace Improvements

Important After updating, you need to restart Android Studio to apply any
memory settings you migrate from an earlier version of the IDE.
Release Notes

Updating 4.1.3 to 4.2 (Al-202.7660.26.42.7322048). Paich size is 650 MB. Configure updates...

Ignore This Update Remind Me Later Update and Restari
Figure 39: Android Studio Update Dialog

“Remind Me Later” will pop up the dialog in the future, while “Update and Restart”
will apply the upgrade now and restart the IDE after upgrading it. “Ignore This
Update” will stop the dialog from appearing automatically, but it will not apply the
update... and usually you want the updates.
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Examining Your Code

When you decided to learn how to write Android apps, most likely you were
thinking about traditional computer programming, using programming languages
like Java and Kotlin. There is a fair amount of such programming involved in
Android apps, though perhaps less than you might think.

In this chapter, we will explore what our starter project contains in terms of the code
and how that code is organized.

The Top Level

”»

Let’s look at our starter project’s tree, as shown in the “Project” view (in the “Project
mode in the drop-down), focusing on the top level of entries:

HelloWorld
B- Project -
» = HelloWorld s

Il External Libraries
! Scratches and Consoles

% 1: Project |

Figure 40: Android Studio Project View, Showing Top Level Entries

You will spend the vast majority of your time in the HelloWorld/ portion of the
project tree, which represents the files that make up your Android app. We will
examine the other two items — “External Libraries” and “Scratches and Consoles” —

a bit later in this chapter.
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The Project Contents

That HelloWorld/ entry contains a fair number of files and subdirectories:

Project ~

HelloWorld [Hello World]
> .gradle
- idea
» build
gradle
% .gitignore
build.gradle
Ligradle.properties
i gradlew
= gradlew.bat
ilocal.properties
settings.gradle
I External Libraries
@ | Scratches and Consoles

=
-

Figure 41: Android Studio Project View, Showing HelloWorld/ Entries

I Project

#= Resource Manager

Most of the time, you will be working in the app/ directory. This is called a “module’,
and it represents something that you are trying to build:

* An app for an Android device

*+ An app for some other specialty scenario, such as an app to be deployed to a
Wear OS smartwatch

* A library to be used by multiple other modules

+ And so on

Your project can have one or several modules; by default, it will just have one,
named app/, for building your Android app. In Android Studio Arctic Fox, a module
directory is denoted by the small dot or square in the corner of the folder icon and a
boldface name.

Some of the files and directories in HelloWorld/ are tied to the Gradle build system,
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which we will discuss later in this book:

* .gradle/

* gradle/

* build.gradle

* gradle.properties
* gradlew

* gradlew.bat

* local.properties
* settings.gradle

The .idea/ directory, along with the build/ directory, are generated from the rest of
the files in your project. You will not need to do anything with these manually —
Android Studio will handle all of that for you.

Android Studio can work with a variety of version control systems, but it has the
tightest integration with Git. When you create a project in Android Studio, it will
create a .gitignore file for you, set up to indicate which files do not need to go into
version control. If you are using Git, this file should be a great starting point, though
you can modify it as needed (e.g., to ignore other files or directories). If you are not
using Git, you can ignore or delete the .gitignore file.
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The App Module Contents

The app/ directory contains the files necessary to build your app:

Project

HelloWorld
.gradle
ddea

=
2,
=
a

[

libs
SIC

> .gitignore
build.gradle

= proguard-rules.pro
Figure 42: Android Studio Project View, Showing app/ Entries

Resource Manager

Most of the time, you will be working in the src/ directory, which contains the
source code and other files that you will be creating and editing to define your app.

The build/ directory here is similar to the build/ directory that is under the
HelloWorld/ root directory. It contains the output of building your app. In this case,
we will use this build/ directory a bit more often, as it contains the actual app itself
that we can distribute through the Google Play Store or other app distribution
channels. We will examine this build/ directory a bit more later in the book.

In a typical starter project, the 1ibs/ directory is empty. It is there to support some
old ways of attaching libraries to your module, for code written by others that you
wish to use. We will explore what libraries are and what ones this project uses in an

upcoming chapter.

The build.gradle file, like its counterpart in the HelloWorld/ root directory,
contains Gradle instructions for how to build your app. We will examine this file in
detail later in the book.

The .gitignore file, like its counterpart in the HelloWorld/ root directory, identifies
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files and directories that can be skipped when putting this project into a Git
repository. While you may need to maintain this file if you are using Git, using Git
and .gitignore is outside the scope of this book.

Last, the proguard-rules.pro file is there in support of ProGuard and related tools.
These are used in Android project for two reasons:

1. They help to reduce the size of the apps, by eliminating stuff from libraries
that we are not really using

2. They “obfuscate” the code in the apps, to make it slightly more difficult for
people to “reverse engineer” the apps and figure out how they work

Until you are ready to think about distributing your app to other users, though,
ProGuard and similar tools are not necessary. Hence, we will postpone looking at
that stuff until much later in the book.

The Generated Source Sets

Inside the src/ directory are “source sets”. These identify different directories of
source code (and related files) that will be used in different circumstances:

Project ~

HelloWorld
.gradle
idea

¥ 1: Project

libs

SIC
androidTest
main
fest

Resource Manager

Figure 43: Android Studio Project View, Showing src/ Entries

There are three source sets that will be created by default for an Android project:
main/, androidTest/ and test/.
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main/

The source set that you will spend most of your time in is main/. This represents the
“main” source code for your app. For most apps, this source set contains all of your
code (and related files) that make up the app itself:

8 Project [ ICJ - ]
g HelloWorld
= .gradle
- .idea
5 app
g libs
2 src
o androidTest
§ main
& java
e com.commonsware.jetpack.hello
& MainActivity
¥ lzres
drawable
< drawable-v24
g layout
i mipmap-anydpi-v26
. mipmap-hdpi
mipmap-mdpi
% mipmap-xhdpi
= mipmap-xxhdpi
; mipmap-xxxhdpi
}E values
-

w0 AndroidManifest.xml

Figure 44: Android Studio Project View, Showing main Source Set Entries

Your Java and Kotlin code will go in a java/ directory inside of the source set. Here,
we see one Kotlin file, named MainActivity.kt (where the .kt part is left off in the
tree).

You will also find:

+ Resources, in the res/ directory, which are files that are not source code but
contribute to your app, such as your icons and other images, as we will see in

an upcoming chapter
* AndroidManifest.xml, which is the “table of contents” of what is in your app,

as we will see in another upcoming chapter
* Optionally other things (assets/, jni/, aidl/, etc.), though these will not be
seen in every Android project
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androidTest/

The androidTest/ source set can have its own Java/Kotlin source code, resources,
and manifest file. Typically, it only has Java and Kotlin source code:

E Project - B - @
£ 7 Iz HelloWorld

il .gradle

- idea

E - app

= libs

5

g SIC |

o androidTest

§ M= java

& ¥ [» com.commonsware.jetpack.hello
Y

[ [ ]

.. ExamplelnstrumentedTest
Figure 45: Android Studio Project View, Showing androidTest Source Set Entries

This source set’s files will not go into your app. Instead, they are for testing your app,
to make sure that your app does what it is supposed to do.
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test/

There is a very similar source set, named test/, in a typical Android project:

E Project = B = o
£ + 1zHelloWorld

il .gradle

- idea

g aep

= libs

o

g sIc _

u androidTest
= _

2 main

& test

e java

¥ [n com.commonsware.jetpack.hello

& ExampleUnitTest
Figure 46: Android Studio Project View, Showing test Source Set Entries

As with androidTest/, test/ can contain its own Java and Kotlin code. And, as with
the androidTest/ source set, the test/ code is not part of your app, but instead is
for testing your app.

The difference between androidTest/ and test/ is in where your tests run:
* androidTest/ tests run inside of an Android device or emulator
* test/ tests run directly on your development machine, in a Java virtual

machine

We will explore that distinction in greater detail, along with the test code in our
starter project, later in the book.

58

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



EXAMINING YOUR CODE

Language Differences

When you import an Android project into Android Studio, you get whatever source
code was in that project. This could be Java, Kotlin, or some combination.

When you create a project from scratch — as we will examine in an upcoming
chapter — you will be able to tell the new-project wizard whether you want it to
generate Java or Kotlin files. When you start working on adding new stuff to your
project, you can add in new Java or Kotlin files.

The HelloWorld sample project that you imported was created using the Android
Studio Arctic Fox new-project wizard, where the author asked for Kotlin files.
Therefore, our two test source sets and the main source set contain Kotlin.

If you would prefer, you can download a Java edition of the same project from the
CommonsWare site. UnZIPping and importing that project gives you the same thing
as the HelloWorld Kotlin project, except that the source code (main/, androidTest/,
and test/) is Java, not Kotlin.

Introducing the Activity

Ignoring the test code for a while, our one-and-only source file in our project
implements a MainActivity class, either in Java or Kotlin. This class represents an
“activity”, one of the core components in an Android app.

The Role of the Activity

The building block of the user interface is the activity. You can think of an activity as
being the Android analogue for the window in a desktop application or the page in a
classic Web app. It represents a chunk of your user interface and, in many cases, a
discrete entry point into your app (i.e., a way for other apps to link to your app).

Normally, an activity will take up most of the screen, leaving space for things like a
status bar (the strip across the top with the clock, battery icon, etc.) and a
navigation bar (the strip across the bottom with buttons for going back, going to the
home screen, etc.)

However, bear in mind that on some devices, the user will be able to work with more
than one activity at a time, such as split-screen mode on a phone or multi-window
mode on a Chrome OS device. So, while it is easy to think of activities as being
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equivalent to the screen, just remember that this is a simplification, and that reality
is more complicated (as reality often is).

In a simple app with one activity, such as this sample app, that activity will serve as
the entry point for the app itself. The user’s home screen will often have an “app
drawer” or similar thing with a bunch of icons. While the user thinks of those as
“running an app’, in reality those icons pass control to an activity inside of the app,
one designated as being something that should appear in a “launcher” or home
screen. What makes an activity appear in this app drawer is based upon stuff found
in the AndroidManifest.xml file, and we will see how that works later in the book.

Examining the Generated Code

When you create a new project via the new-project wizard — as this sample app was
— usually you will have that wizard create your first activity for you. The activity will
have the same functionality regardless of whether you asked for Java or Kotlin code.
Since Java and Kotlin do not have the same syntax, those files will not be identical in
code, but they will be identical in functionality.

So, let’s see what our sample app’s activity looks like, in both languages.

Java

The HelloWorldJava.zip version of the sample app was created using Java as the
requested programming language. So, our main source set has MainActivity.java in
a com.commonsware. jetpack.hello Java package:

package com.commonsware.jetpack.hello;

import androidx.appcompat.app.AppCompatActivity;
import android.os.Bundle;

public class MainActivity extends AppCompatActivity {

@Override
protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
}
b
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Kotlin

The HelloWorld.zip version of the sample app was created using Kotlin as the
requested programming language. So, our main source set has MainActivity.kt in
that same Java-style package (com.commonsware.jetpack.hello):

package com.commonsware.jetpack.hello

import androidx.appcompat.app.AppCompatActivity
import android.os.Bundle

class MainActivity : AppCompatActivity() {
override fun onCreate(savedInstanceState: Bundle?) {
super .onCreate(savedInstanceState)
setContentView(R.layout.activity_main)
}
}

Code Commonalities

While Java and Kotlin differ in syntax, both activities are doing the same thing and
are using the same things from the Android SDK.

AppCompatActivity

All activities in Android inherit from an android.app.Activity base class. In our
case, MainActivity does not inherit directly from that class. Instead, it extends
androidx.appcompat.app.AppCompatActivity. That, in turn, inherits from
android.app.Activity, so MainActivity has Activity in its inheritance hierarchy.

Technically, you do not need AppCompatActivity — you could inherit from
something else, even from Activity itself. However, Google is making it difficult for
you to extend from anything else other than AppCompatActivity. When you create a
new project, it is very likely that you will be given an activity that extends from
AppCompatActivity.

The theory is that AppCompatActivity makes it easier for you to develop apps that
will behave consistently across many versions of Android, compared to inheriting
from Activity or some other subclass of Activity.

We will see more about where AppCompatActivity comes from a bit later in this
chapter.
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onCreate()

MainActivity has one Java method or Kotlin function: onCreate(). This overrides
an onCreate() method that we inherit. Our job in onCreate() is to set up the basic
UI that is to be shown by this activity.

In reality, onCreate() is just one of a series of “lifecycle methods”, methods or
functions that get called as our activity is coming onto the screen, leaving the
screen, and so on. We will see more about lifecycles later in the book.

The very first thing that we do in onCreate() is chain to the inherited
implementation of onCreate(), via a call to super.onCreate(). This is a very typical
pattern for onCreate() of an activity, as the activity is not fully initialized until after
super.onCreate() has been called. So, we try to get that out of the way early, so we
are safe to do the rest of our work afterwards.

setContentView()

The other thing that we do in onCreate() is call a setContentView() method. This
says “Hey, Android! The UI that we want to show starts with this!”. We supply
something to serve as the foundation for our Ul, which we can further tailor if
needed. Calling setContentView() is not required, but it is a fairly typical approach.

In this case, we pass in a funny-looking value to setContentView():
R.layout.activity_main. This serves as a reference to a layout resource, named
activity_main. We will explore resources in the next chapter, including an

explanation of what this R thing is.
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Line Numbers

You may have noticed that some of the screenshots in this book that show the
editing pane show line numbers in the gutter area on the left:

package com.commonsware. jetpack.hello
import ...
«s class MainActivity : AppCompatActivity() {
of override fun onCreate(savedInstanceState: Bundle?) {

super.onCreate(savedInstanceState)
setContentView(R.layout.activity main)

}

Figure 47: Android Studio Source Editor, Showing Line Numbers

Those will not be enabled by default. If you want to enable them, you have two main
options.
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Per Editor

If you temporarily want to show line numbers, choose “View” > “Active Editor” from
the main menu, and toggle on “Show Line Numbers”:

luavigate Code Analyze Refactor Build Run Tools VC!

H Tool Windows
N Appearance
Quick Definition
Show Siblings

2

Quick Documentation Ctrl+Q
Parameter Info Ctrl+P
Type Info Ctrl+Shift+P
Context Info Alt+Q
Recent Files Ctri+E
Recently Changed Files
Recent Locations Ctri+Shift+E
Recent Changes Alt+Shift+C
4" Compare With... Ctrl+D
I3+ Compare with Clipboard
Quick Switch Scheme... Cirl+
Bidi Text Base Direction
test
> -gitignore
build.gradle
£ proguard-rules.pro
build

e

Ctri+Shift+l & MainActivity.kt

| » & o
com commonsware
1 package c
2
3 import
b | class Mai
7 @ overrid
8 super
9 setCo
LO o }
L1 }
Soft-Wrap
Show Whitespaces

+ Show Gutter Icons

v Show Indent Guides
v Show Breadcrumbs
v Show Import Popups

Figure 48: Android Studio, Showing “Show Line Numbers” Option
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All the Time

If you wish to have line numbers be toggled on by default, choose “File” > “Settings”

from the main menu (or “Android Studio” > “Preferences...” on macOS). Go into
“Editor” > “Appearance” and check “Show line numbers”, then click “OK”:

Settings o

Editor » General » Appearance

Appearance & Behavior Caret blinking (ms): 500
Keymap ["] Use block caret
Editor Show hard wrap and visual guides (configured in Code Style options)
General Show line numbers
Auto Import IEI Show method separators
| Show whitespaces
Breadcrumbs

Code Completion

Code Folding Show indent guides

Console Show intention bulb

Editor Tabs Show code lens on scrollbar hover
Guitter Icons

Enable HTML/XML tag tree highlighting
Levels to highlight: 6 %

Postfix Completion
Smart Keys
Font Opacity: 01 =+
Color Scheme
General
Language Defaulis
Color Scheme Font
Console Font
Console Colors
Debugger
Diff & Merae

m Cancel Help
Figure 49: Android Studio, Showing “Show Line Numbers” Setting

We will be exploring other options in this Settings screen throughout the book.

Other Things in the Project Tree

The project tree, starting at the HelloWorld/ root node, contains all of the stuff that
makes up the project. However, the project tree itself also contains two other root
nodes: “External Libraries” and “Scratches and Consoles”.

External Libraries

The more important of the two, by far, is “External Libraries”, though you will only
need to examine this area of the project tree on occasion.
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MainActivity is fairly small. It can be that small because “it stands upon the
shoulders of giants”. In this case, those “giants” are libraries.

Our tiny app pulls in a very long list of libraries:

¥ |l External Libraries

< Android API 30 Platform >

<18>

Gradle: androidx.activity:activity:1.0.0@aar

Gradle: androidx.annotation:annotation:1.1.0@jar

Gradle: androidx.appcompatappcompat1.1.0@aar

Gradle: androidx.appcompatappcompat-resources:1.1.0@aar
Gradle: androidx.arch.core:core-common:2.1.0@jar

Gradle: androidx.arch.core:core-runtime:2.0.0@aar

Gradle: androidx.collection:collection:1.1.0@jar

Gradle: androidx.constraintlayout:constraintiayout:1.1.3@aar
Gradle: androidx.constraintlayout:constraintlayout-solver:1.1.3@jar
Gradle: androidx.core:core:1.3.1@aar

Gradle: androidx.core:core-ktx:1.3.1@aar

Gradle: androidx.cursoradapter.cursoradapter:1.0.0@aar
Gradle: androidx.customview:customview:1.0.0@aar
Gradle: androidx.drawerlayoutdrawerlayout1.0.0@aar
Gradle: androidx.fragment:fragment:1.1.0@aar

Gradle: androidx.interpolator:interpolator:1.0.0@aar

Gradle: androidx.lifecycle:lifecycle-common:2.1.0@jar
Gradle: androidx.lifecycle:lifecycle-livedata:2.0.0@aar
Gradle: androidx.lifecycle:lifecycle-livedata-core:2.0.0@aar
Gradle: androidx.lifecycle:lifecycle-runtime:2.1.0@aar
Gradle: androidx.lifecycle:lifecycle-viewmodel:2.1.0@aar
Gradle: androidx.loader:loader:1.0.0@aar

Gradle: androidx.savedstate:savedstate:1.0.0@aar

in Gradle: androidx.test.espresso:espresso-core:3.2.0@aar

Figure 50: Android Studio External Libraries List (Partial)

This is not a complete list — the list is so long, it cannot fit in a single screenshot.

Most of these libraries come from Google and are part of the Android SDK. Some are
from other developers, such as libraries from JetBrains in support of Kotlin.

We will see in an upcoming chapter where these libraries come from and why they
are all being used to build this little app.

Scratches and Consoles

The last item, “Scratches and Consoles”, is almost completely undocumented and
seems to be infrequently used. Among other things, via the right-mouse context
menu, you can create new “scratch files” here, useful for notes or testing
programming language syntax outside the scope of actual project code.
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Exploring Your Resources

Resources are static bits of information held outside the Java/Kotlin source code. As
we discussed previously, resources are stored as files under the res/ directory in
your source set (e.g., app/src/main/res/). Here is where you will find all your icons
and other images, your externalized strings for internationalization, and more.

These are separate from the Java/Kotlin source code not only because they are
different in format. They are separate because you can have multiple definitions of a
resource, to use in different circumstances. For example, with internationalization,
you will have strings for different languages. Your Java/Kotlin code will be able to
remain largely oblivious to this, as Android will choose the right resource to use,
from all candidates, in a given circumstance (e.g., choose the Spanish string if the
device’s locale is set to Spanish).

In this chapter, we will examine the resources in our starter project and what their
roles are in Android app development. Later chapters will cover more about these
resources and describe other types of resources that your project can have.
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What You See in res/

If you look at the app/src/main/res/ directory of your project, you will see a fairly
long list of subdirectories:

drawable
drawable-v24
layout
mipmap-anydpi-v26
mipmap-hdpi
mipmap-mdpi
mipmap-xhdpi
mipmap-xxhdpi
mipmap-xxxhdpi
values

- colors.xml

= strings.xml

- Styles.xml

Figure 51: Resource Directories in Android Studio

Resources are placed into directory based in part on the resource type. That forms
the base name of the directory, such as drawable and layout. Some directories
contain a suffix after this, such as the -v24 part of drawable-v24. That suffix
indicates a particular resource set, which we will examine more shortly.

But first, we need to talk about API levels.

OS Versions and API Levels

Android has come a long way since the early beta releases from late 2007. Each new
Android OS version adds more capabilities to the platform and more things that
developers can do to exploit those capabilities.

Moreover, the core Android development team tries very hard to ensure forwards

68

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



EXPLORING YOUR RESOURCES

and backwards compatibility. An app you write today should work unchanged on
future versions of Android (forwards compatibility), albeit perhaps missing some
features or working in some sort of “compatibility mode”. And there are techniques
for creating apps that will work both on the latest and on previous versions of
Android (backwards compatibility).

To help us keep track of all the different OS versions that matter to us as developers,
Android has API levels. A new API level is defined when an Android version ships
that contains changes that affect developers. When you create an emulator AVD to
test your app, you will indicate what API level that emulator should emulate. When
you distribute your app, you will indicate the oldest API level your app supports, so
the app is not installed on older devices.

We started with API Level 1 and Android 1.0... but that was a long time ago.
Nowadays, the focus tends to be on newer versions of Android and corresponding
higher API levels. Here, though, Android gets a bit complicated, as there are a lot of
different versions of Android being used today.

Google used to publish up-to-date version information on its dashboards page, but
they abandoned that a while ago. Instead, they rely on you creating a new project
and looking at a version distribution chart available from the new project wizard.
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Or, you could just look at the copy of that chart shown here:

ANDROID PLATFORM API LEVEL CUMULATIVE
VERSION DISTRIBUTION

4.1 16 ~ 99.8%
4.2 17 99.2%
4.3 18 2t
5.0 21 =i
= 22 92.3%
- 53 84.9%
o >4 73.7%
66.2%

- Sen cos%
- >7 53.5%
39.5%

9.0 28

Figure 52: Android OS Distribution Chart, from Android Studio 4.2.1

The chart shows the various Android versions, their API level numbers, and the
“cumulative distribution”. The cumulative distribution shows you what percentage of
the Android device ecosystem you can reach if your minSdkVersion is set to that
particular API level. Their numbers are based on devices using the Play Store and
therefore will miss many devices that are based on other distribution channels.

This book focuses on Android 5.0 (API Level 21) and higher. There are ways to
support older devices than that, but supporting older than Android 4.4 (API Level
19) gets complicated, so this book skips that to help keep the explanations simple.

At the time that this chapter was last updated, the latest production version of
Android was 12 (API Level 31). This is not shown in the chart, because Google

appears to have forgotten to update the chart in over a vear.

Beyond the latest production version, from time to time we are given “developer
previews” of an upcoming version of Android. These are not good choices for new
Android developers to worry about, but experienced developers may be interested in
testing on pre-release Android versions and trying to use upcoming features. For
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example, in February 2021, Google announced “Android S” and released the first
developer preview of what became Android 12.

Decoding Resource Directory Names

Our app has a bunch of resource directories. Some have simple names, like
drawable/ and layout/. Others have suffixes, like drawable-v24/ and mipmap-hdpi/.

The initial segment of the directory name — or the whole name for those that lack
suffixes — usually indicates the type of the resource. There are many resource types
in Android, and we will explore a few of them in this chapter. The exception is the
values/ directory, which can contain a variety of smaller resource types, not just one
“values” type.

The suffixes represent “resource sets”, and they indicate that this directory contains
resources of a particular type that should only be used in certain scenarios. We call
these scenarios “configurations”; the suffixes indicate what configurations those
resources are used for.

For example:

* drawable/ has resources that are good for any configuration, but drawable-
v24/ has resources that are only going to be used on API Level 24 and higher
devices (i.e., Android 7.0 and higher)

* mipmap-anydpi-v26/ has resources that are good for any screen density, but
they will only be used on API Level 26 and higher devices

* mipmap-mdpi/ has resources that are designed around “medium density”
screens, where the density is around 160dpi (dpi = dots per inch)

We will explore these rules more later in the book, as they get fairly complex fairly
quickly.

Our Initial Resource Types

Our starter app contains six types of resources, though two of them (drawables and
mipmaps) are pretty much the same thing.

Layouts

The resource type that will consume most of your time is the layout resource. This
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describes a chunk of our app’s user interface. That chunk could be:

+ A screen

* Arowin alist

* Acellin a grid

* A reusable piece that you want to apply to several different screens
* And so on

Layout resources are XML files that either you create by hand or create through the
use of drag-and-drop GUI builders built into Android Studio. We will be spending
quite a bit of time covering layout resources throughout this book, starting with a
chapter on widgets, our smallest pieces of a layout resource.

The starter project has a fairly simple layout... though it could be even simpler:

<?xml version="1.0" encoding="utf-8"?>

<androidx.constraintlayout.widget.ConstraintlLayout
xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:app="http://schemas.android.com/apk/res-auto"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context=".MainActivity">

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Hello World!"
app:layout_constraintBottom_toBottomOf="parent"
app:layout_constraintLeft_tolLeftOf="parent"
app:layout_constraintRight_toRightOf="parent"
app:layout_constraintTop_toTopOf="parent" />

</androidx.constraintlayout.widget.ConstraintlLayout>

As we will see, XML elements generally will map to widgets (things that users touch)
and containers (things that organize widgets and other containers). So, here, we
have a ConstraintLayout container that wraps around a single TextView widget.

In the chapter on widgets, we will explore this XML structure in detail, plus show
you how you can set up this XML through the drag-and-drop GUI builder.
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Drawables and Mipmaps

All apps have some amount of artwork, mostly in the form of icons. For example,
most apps have an icon that will appear in the home screen or launcher app, that
allows the user to bring up the app’s Ul. Apps might have other icons in that Ul, to
appear on buttons or other tappable things. Some apps may use a “splash screen” as
an introductory bit of UI, and so they have some large graphic that they want to use
for that screen. And there are many other uses of artwork within an Android app, of
relevance to some apps but perhaps not to others.

Sometimes, these graphics are downloaded from the Internet as part of running the
app. Most of the rest are packaged with the app itself: the graphic designer creates
the artwork and the developer arranges to use it in the app in the appropriate place.

Most of these pre-packaged bits of artwork are in the form of drawable and mipmap
resources.

Many of these are bitmap images: PNG, JPEG, etc. They can also be:

* Vector art, imported from SVG files that your graphic designer might prepare
in tools like Adobe Illustrator

* Specialized XML files, usually with rules for how to combine two or more
other resources together

There are really boring technical distinctions between drawables and mipmaps, and
tedious historical explanations for why we have two different resource types for the
same stuff. For the purposes of this book — and so you do not fall asleep while
reading it — you do not need to worry about all of that. The rules for the vast
majority of Android developers are fairly simple:

* Your home screen launcher icon is a mipmap
+ Everything else is a drawable

We will start exploring these resources more in an upcoming chapter where we
change your launcher icon.

Strings
Keeping your labels and other bits of text outside the main source code of your

application is generally considered to be a very good idea. In particular, it helps with
internationalization (18N) and localization (LioN). Even if you are not going to
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translate your strings to other languages, it is easier to make corrections if all the
strings are in one spot instead of scattered throughout your source code.

Strings are one of the “values” resource types. So, in the values/ directory, we can
have one or several files that contain string resources. Typically, you have just one
such file, named strings.xml.

The starter app’s strings.xml file contains... not very much:

<resources>
<string name="app_name">Hello World</string>
</resources>

All files in the values/ directory will be XML files with a root <resources> element.

What appears inside that root element defines the actual resources contained in
that file.

Inside strings.xml, the <resources> element contains just one child element: a
<string>, defining a single string resource. Each string resource has a name, which is
how we will refer to that string from elsewhere in the app. And, each string resource
has a value, consisting of the text between the <string>and </string> tags. Here,
we define app_name to be “HelloWorld”.

The starter app does not have translations of this resource, but it could. For
example, it could contain a res/values-es/ directory, containing strings to be used
for devices whose locale is set to Spanish. In there, app_name might be defined as
“Hola Mundo”. On the fly, Android will choose the right translation to use, based on
the translations that you provide and the locale of the device.

We will be working with a bunch of string resources in this book, and we will
explore the issues of translations a bit more in a later chapter.

Colors

Another type of “values” resource is the color resource. As you might expect, it
provides a symbolic name for colors. This allows us to give names that have
semantic meaning (e.g., “the standard accent color”) and use those names in our
code. It also then gives us one place to define what the actual color is for that name,
so if we need to change the color, we can change it in one place.

Color resources are defined by <color> elements in a “values” resource file.
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Convention says that your colors go into a colors.xml resource file, and that is what
the starter app has:

<?xml version="1.0" encoding="utf-8"?>

<resources>
<color name="purple_200">#FFBB86FC</color>
<color name="purple_500">#FF6200EE</color>
<color name="purple_700">#FF3700B3</color>
<color name="teal_200">#FF03DAC5</color>
<color name="teal_700">#FF018786</color>
<color name="black">#FF000000</color>
<color name="white">#FFFFFFFF</color>

</resources>

As with our app_name string resource, just having these colors does not cause
anything to use those colors. That requires additional code or additional resources,
ones that happen to reference these resources.

Styles and Themes

A place where color resources are often used is in style resources. Style resources are
reminiscent of CSS stylesheets in Web development. Styles allow you to give a name
to a collection of Ul properties, then apply those properties to various scenarios.

One such scenario is where a style is used as a “theme”. This provides the defaults for
UI properties for an entire activity, or perhaps even the entire app. The sample
project defines one such theme, AppTheme, in its themes.xml file:

<resources xmlns:tools="http://schemas.android.com/tools">

<!-- Base application theme. -->
<style name="Theme.HelloWorld" parent="Theme.MaterialComponents.DayNight.DarkActionBar">
<!-- Primary brand color. -->

<item name="colorPrimary">@color/purple_500</item>
<item name="colorPrimaryVariant">@color/purple_700</item>
<item name="colorOnPrimary">@color/white</item>
<!-- Secondary brand color. -->
<item name="colorSecondary">@color/teal_200</item>
<item name="colorSecondaryVariant">@color/teal_700</item>
<item name="colorOnSecondary">@color/black</item>
<!-- Status bar color. -->
<item name="android:statusBarColor" tools:targetApi="1">
?attr/colorPrimaryVariant
</item>
<!-- Customize your theme here. -->
</style>
</resources>

The parent attribute on the <style> indicates that we are inheriting existing Ul
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property definitions from something called
Theme.MaterialComponents.DayNight.DarkActionBar. That name has lots of pieces:

* Theme indicates that we are starting from the base system theme

* MaterialComponents indicates that this theme comes from a library referred
to as the Material Components for Android

+ DayNight indicates that the general look is dark text on a light background
during the daytime, and light text on a dark background at night

* DarkActionBar says that the “app bar” — the toolbar structure towards the
top of the screen of most Android activities, formerly called an “action bar”
— should have white icons on a dark background

10:17 @

My Application

Figure 53: Top Part of an Android Activity, Annotated

AppTheme inherits from Theme .MaterialComponents.DayNight.DarkActionBar, so we
get lots of stuff “for free” as a result. We then override additional UI properties as we
see fit, such as colorPrimary, which the Material Components will use for the app
bar background, the foreground text in the main Ul area, and a few other roles.

The AppTheme style refers to the color resources that were defined in the colors.xml
file. In resources, when you need to refer to another resource, you do so using the
syntax @type/name, where type is the type of the resource (color, string, drawable,
mipmap, etc.), and name is the name of the resource. For “values” resources, like our
colors, the name comes from the name attribute of the element that defines the
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resource. For all other types of resources, the name comes from the filename of the
resource file, without the file extension. So, here, @color/colorPrimary refers to the
colorPrimary color resource.

Note that the resource references do not include any of those suffixes on the
directory names that we use for resource sets. If you look in the various directories
for mipmap resources, you will see that we have six different variations of an
ic_launcher mipmap:

* mipmap-anydpi-v26/ic_launcher.xml
* mipmap-hdpi/ic_launcher.png

* mipmap-mdpi/ic_launcher.png

* mipmap-xhdpi/ic_launcher.png

* mipmap-xxhdpi/ic_launcher.png

* mipmap-xxxhdpi/ic_launcher.png

However, when things like our manifest refer to these, it is always as @mipmap/
ic_launcher. Android will decide, on the fly, which of these six definitions to use,
based on the rules encoded in those directory names and the configuration of the
device at the time we are trying to use the resource. We will get much more into all
of that complexity later in the book.

About That R Thingy

When we were looking at the source code to MainActivity, we saw this line:

setContentView(R.layout.activity_main)

setContentView() tells the activity “this is the UI to display”. The
R.layout.activity_main value is a reference to our activity_main.xml layout
resource.

Just as we refer to our app’s resources from other resources using @type/name syntax,
we refer to our app’s resources from Java and Kotlin using R. type.name syntax. The
same rules apply:

* The type is the type of the resource (e.g., Layout), not counting any suffixes
that might be on the directory name

* The name is the name attribute of a “values” resource or the filename of other
types of resources, excluding the file extension

77

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



EXPLORING YOUR RESOURCES

Occasionally, you will try to refer to an R value and the IDE will say that it cannot
find that value. We will explore this problem more in a bit later in the book.

The Resource Manager

Android Studio also has a “Resource Manager” tool. This is designed to help you
navigate some key types of resources more easily, such as:

* Drawables and mipmaps
+ Colors

+ Layouts

+ Strings

This tool is accessible via a “Resource Manager” button, docked by default on the left
edge of the Android Studio window.

HelloWorld app src main res drawable
Resource Manager o —

+ S Module: My_Ap} ~ T

I 1: Project

Drawable Color Layout MipMap  String

My_Application.app (2)

ic_launcher_background
Drawable | 1 version

3+ Resource Manager

ic_launcher_foreground
Drawable | 1 version

& 7: Structure

»* 2: Favorites

K Build variants

Figure 54: Android Studio Resource Manager, As Initially Opened

There are a set of tabs towards the top that allow you to toggle between the three
sets of resources that this tool supports. By default, each tab’s contents is a list, but
there are buttons towards the bottom of the tool to toggle between list and grid
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modes:

HelloWorld app SIC main res
Resource Manager o —

+ | Module: app - T

¥ 1: Project

Drawable Color Layout MipMap String

app (3)

2+ Resource Manager

colorAccent colorPrimary
#03dacs

acs #6200ee

= 7: Structure

colorPrimaryDark

Al Layout Captures

1 version

Build Variants

= @

Figure 55: Android Studio Resource Manager, Showing a Grid of Color Resources,
With Toggle Buttons Highlighted

Double-clicking on a resource opens up an editor window for it, while right-clicking
over a resource provides options for copying it, renaming it, etc.

The + icon in the toolbar towards the top lets you add new drawable resources, using
the Image Asset Wizard or Vector Asset Wizard, both of which we will see in
upcoming chapters.

For larger projects, this can be useful to help you find resources. In particular, the
Drawable tab can be very handy for identifying if you already have a piece of artwork
in your app or whether you need to add it.
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Inspecting Your Manifest

A key part of the foundation for any Android application is the manifest file:
AndroidManifest.xml. This will be in your app module’s src/main/ directory (the
main source set) for typical Android Studio projects.

Here is where you declare what is inside your application, such as your activities.
You also indicate how these pieces attach themselves to the overall Android system,;
for example, you indicate which activity (or activities) should appear on the device’s
launcher.

When you create your application, you will get a starter manifest generated for you.
For a simple application, offering a single activity and nothing else, the auto-
generated manifest will require a few minor modifications, but otherwise it will be
fine. Some apps will have a manifest that has 1,000+ lines. Your production Android
applications probably will fall somewhere in the middle.

The Root Element

Here is the AndroidManifest.xml file from the starter project:

<?xml version="1.0" encoding="utf-8"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.commonsware.jetpack.hello">

<application
android:allowBackup="true"
android:icon="@mipmap/ic_launcher"
android:label="@string/app_name"
android:roundIcon="@mipmap/ic_launcher_round"
android:supportsRtl="true"
android:theme="@style/Theme.HelloWorld">

81

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



INSPECTING YOUR MANIFEST

<activity
android:name=".MainActivity"
android:exported="true">
<intent-filter>
<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>
</application>

</manifest>

The root <manifest> element usually does not contain too much. It will have one or
more XML namespace declarations. Here, we have just one, defining the android
namespace, which is used for most of the attributes that you will find in the
manifest file. We will see other manifests later on that have other namespace
declarations (e.g., tools), but usually there are not too many of them.

The key attribute in the <manifest> element is package. This indicates where the
build tools will generate some Java code for use by your app. We will explore that
generated code later in the book.

The Application Element

There can be many child elements of the root <manifest> element. Over the course
of this book, we will see ones like <uses-permission> that appear in these
manifests.

However, the most important child element by far is <application>. This describes
the app that is using this manifest.

In a significant Android app, most of what goes in the manifest consists of child
elements of <application>, such as the <activity> element. Beyond that, the
<application> element:

» Provides defaults for behavior of those activities, such as what theme is used
to specify colors and such (android: theme)

* Provides details about the app that get used by other apps (e.g., Settings),
such as the app’s display name (android:label) and icon (android:icon
and, sometimes, android: roundIcon)

+ Configures overall app behavior, such as whether it handles right-to-left
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languages (a.k.a., RTL), such as Arabic and Hebrew (android:supportsRtl)

+ Configures certain aspects of how the app integrates with the rest of the
operating system, such as whether it wishes to participate in device-wide
backups (android:allowBackup)

We will explore many of these attributes as we proceed in this book.

The Activity Element (And Its Children)

The children of <application> mostly represent the “table of contents” for the app.

Android has four major types of “components™:

* Activities, representing the Ul

+ Services, representing background processing that is decoupled from the Ul
+ Content providers, which expose databases or data streams to other apps or
the operating system

* Broadcast receivers, which supply the “subscriber” side of a publish/

subscribe messaging system used by apps and the operating system to
communicate

Most of these will be registered in the manifest via corresponding child elements of

<application>:
Component Element

Activity <activity>

Service <service>

Content Provider | <provider>

Broadcast Receiver | <receiver>

Your app may have several of one type, such as having several activities. Your app

may have none of a particular type, such as having no broadcast receivers registered
in the manifest.

Our starter app has a single <activity> element, and nothing more:
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<activity
android:name=".MainActivity"
android:exported="true">
<intent-filter>
<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>

<activity> elements have an android:name attribute. This will identify the Java or
Kotlin class that contains the implementation of the activity. The android:name
attribute, in this case, has a bare Java class name prefixed with a single dot
(.MainActivity). Sometimes, you will see android:name with a fully-qualified class
name (e.g., com.commonsware.helloworld.MainActivity). Sometimes, you will see
just a bare Java class name (e.g., MainActivity). Both MainActivity and
.MainActivity refer to a Java class that will be in your project’s package — the one
you declared in the package attribute of the <manifest> element.

Sometimes, an <activity> element will have an <intent-filter> child element
describing under what conditions this activity will be displayed. Most apps will have
at least one <activity> element that sets up your activity to appear in the launcher,
so users can choose to run it. That is what this <intent-filter> element does,
though the details of how that works are beyond the scope of this particular book.
Suffice it to say that whenever you see an <activity> element with this particular
<intent-filter> (an <action> of android.intent.action.MAIN and a <category>
of android.intent.category.LAUNCHER), you know that this activity should appear
in the launcher for the user to be able to start.

The other component elements — <service>, <provider>, <receiver> — will have
similar characteristics:

* They all will have an android:name attribute, identifying the code that serves
as the implementation for that component

+ They might have an <intent-filter>

* They might have other attributes as well (e.g., android:permission)
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In the discussion of Android Studio, this book has mentioned something called
“Gradle”, without a lot of explanation.

In this chapter, the mysteries of Gradle will be revealed to you.

(well, OK, some of the mysteries...)

Gradle: The Big Questions

First, let us “set the stage” by examining what this is all about, through a series of
fictionally-asked questions (FAQs).

What is Gradle?

Gradle is software for building software, otherwise known as “build automation
software” or “build systems”. You may have used other build systems before in other
environments, such as make (C/C++), rake (Ruby), Ant (Java), Maven (Java), etc.

These tools know — via intrinsic capabilities and rules that you teach them — how
to determine what needs to be created (e.g., based on file changes) and how to
create them. A build system does not compile, link, package, etc. applications
directly, but instead directs separate compilers, linkers, and packagers to do that
work.

Gradle, as used by default in Android Studio Arctic Fox, uses a domain-specific
language (DSL) built on top of Groovy to accomplish these tasks.
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What is Groovy?

There are many programming languages that are designed to run on top of the Java
VM. Kotlin is one of particular importance for Android developers. Groovy is
another.

As with Java, Groovy supports:

* Defining classes with the class keyword

* Creating subclasses using extends

+ Importing classes from external JARs using import
* Defining method bodies using braces ({ and })

* Objects are created via the new operator

Groovy also resembles Kotlin in some ways:

* You can have free-standing statements outside of a class

* You can use string interpolation (e.g., "Hello, $name" to dynamically insert
a name value into the string)

* You can skip types on variable declarations (e.g., def foo = 1;, akin to var
foo = 1in Kotlin)

What Does Android Have To Do with Gradle?

Google has published the Android Gradle Plugin, which gives Gradle the ability to
build Android projects. Google is also using Gradle and the Android Gradle Plugin
as the build system behind Android Studio.

Hey, | Thought | Read That Gradle Used Kotlin Scripts?

There is an option, starting with Android Studio 4.0, to use Kotlin scripts for
defining your Gradle builds, instead of Groovy scripts. If you see a project with
build.gradle.kts files instead of build. gradle files, that project is using Kotlin
Gradle scripts instead of Groovy ones.

This is likely to prove to be the long-term direction for Android. However, this book
is going to focus on Groovy scripts, for a few reasons:

* The new-project wizard still generates Groovy scripts
* The vast majority of existing projects — such as the one you might start
helping on — will be using Groovy scripts
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* In the end, both scripts wind up doing the same work, with the sole
difference being some syntax variances between Groovy and Kotlin

Obtaining Gradle

If you will only be using Gradle in the context of Android Studio, the IDE will take
care of getting Gradle for you. If, however, you are planning on using Gradle outside
of Android Studio (e.g., command-line builds), you will want to consider where your
Gradle is coming from. This is particularly important for situations where you want
to build the app outside of an IDE, such as using a continuous integration (CI)
server, like Jenkins or Circle CI.

Also, the way that Android Studio works with Gradle — called the Gradle Wrapper

— opens up security issues for your development machine, if you like to download
open source projects from places like GitHub and try using them.

Direct Installation

What some developers looking to use Gradle outside of Android Studio will wind up
doing is installing Gradle directly.

The Gradle download page contains links to ZIP archives for Gradle itself: binaries,
source code, or both.

You can unZIP this archive to your desired location on your development machine.

OS Packages

You may be able to obtain Gradle via a package manager for your particular
operating system

The gradlew Wrapper

A brand new Android Studio project — and many of those that you will find in
places like GitHub — will have a gradlew and gradlew.bat file in the project root,
along with a gradle/ directory. This represents the “Gradle Wrapper”.

The Gradle Wrapper consists of three pieces:

+ the batch file (gradlew.bat) or shell script (gradlew)

87

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.


https://www.gradle.org/downloads
https://gradle.org/install/#with-a-package-manager
https://www.gradle.org/docs/current/userguide/gradle_wrapper.html

REVIEWING YOUR GRADLE SCRIPTS

+ the JAR file used by the batch file and shell script (in the gradle/wrapper/
directory)
* the gradle-wrapper.properties file (also in the gradle/wrapper/ directory)

Android Studio uses the gradle-wrapper.properties file to determine where to
download Gradle from, for use in your project, from the distributionUrl property
in that file:

#Sat Sep 11 19:07:11 EDT 2021

distributionBase=GRADLE_USER_HOME
distributionUrl=https\://services.gradle.org/distributions/gradle-7.0.2-bin.zip
distributionPath=wrapper/dists

zipStorePath=wrapper/dists

zipStoreBase=GRADLE_USER_HOME

When you create or import a project, or if you change the version of Gradle

referenced in the properties file, Android Studio will download the Gradle pointed
to by the distributionUrl property and install it to a .gradle/ directory (note the
leading .) in your project. That version of Gradle will be what Android Studio uses.

RULE #1: Only use a distributionurl that you trust.

If you are importing an Android project from a third party — such as something that
you download from GitHub — and they contain the gradle/wrapper/gradle-
wrapper .properties file, examine it to see where the distributionUrl is pointing
to. If it is loading from services.gradle.org, or from an internal enterprise server,
it is probably trustworthy. If it is pointing to a URL located somewhere else, consider
whether you really want to use that version of Gradle, as it may have been modified
by some malware author.

The batch file, shell script, and JAR file are there to support command-line builds. If
you run the gradlew command, it will use a local copy of Gradle installed in
.gradle/ in the project. If there is no such copy of Gradle, gradlew will download
Gradle from the distributionUrl, as does Android Studio. Note that Android
Studio does not use gradlew for this role — that logic is built into Android Studio
itself.

RULE #2: Only use a gradlew that you REALLY trust.

It is relatively easy to examine a .properties file to check a URL to see if it seems
valid. Making sense of a batch file or shell script can be cumbersome. Decompiling a
JAR file and making sense of it can be rather difficult. Yet, if you use gradlew that

88

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



REVIEWING YOUR GRADLE SCRIPTS

you obtained from somebody, that script and JAR are running on your development
machine, as is the copy of Gradle that they install. If that code was tampered with,
the malware has complete access to your development machine and anything that it
can reach, such as servers within your organization.

Examining the Gradle Files

An Android Studio project usually has two build.gradle files, one at the project
level and one at the “module” level (e.g., in the app/ directory).

The Project-Level File

The build.gradle file in the project directory controls the Gradle configuration for
all modules in your project. The starter project has the single app module, and many
projects only need one module.

If you downloaded the Kotlin edition of the starter project, your top-level
build.gradle looks like this:

// Top-level build file where you can add configuration options common to all sub-projects/modules.
buildscript {
repositories {
google()
mavenCentral()
}
dependencies {
classpath "com.android.tools.build:gradle:7.0.2"
classpath "org.jetbrains.kotlin:kotlin-gradle-plugin:1.5.30"

// NOTE: Do not place your application dependencies here; they belong
// in the individual module build.gradle files
}
+

task clean( Delete) {
delete rootProject.buildDir
}

If instead you have the Java-based starter project, you will have a very similar
build.gradle file, one without the Kotlin references:

// Top-level build file where you can add configuration options common to all sub-projects/modules.
buildscript {
repositories {
google()
mavenCentral()
}

dependencies {
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classpath "com.android.tools.build:gradle:7.0.2"

// NOTE: Do not place your application dependencies here; they belong
// in the individual module build.gradle files
¥
+

task clean( Delete) {
delete rootProject.buildDir

b

In either case, the file contains three things (besides an opening comment):

* abuildscript closure
* an allprojects closure
* aclean task

In Groovy terms, a “closure” is a block of code wrapped in braces ({ }).

There are three main closures in the project-level build.gradle file.

buildscript

The buildscript closure in Gradle is where you list sources of plugins that you want
to use in the project. Hence, here you are not configuring your project so much as
you are configuring the build itself.

The repositories closure inside the buildscript closure indicates where plugins
can come from. Here, jcenter () is a built-in method that teaches Gradle about
JCenter, a popular location for obtaining open source libraries. Similarly, google() is
a built-in method that teaches Gradle about a site where it can download plugins
from Google.

The dependencies closure indicates libraries that contain Gradle plugins. In the
Kotlin edition of the build.gradle file, there are two such dependencies:

+ com.android.tools.build:gradle, which is where the Android Plugin for
Gradle comes from, which teaches Gradle how to build Android apps

* org.jetbrains.kotlin:kotlin-gradle-plugin, which teaches Gradle how
to compile Kotlin source code

(the Java edition of the project will lack the Kotlin plugin)

The identifiers of the libraries (e.g., com.android.tools.build:gradle) are followed
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by a version number, indicating what particular version of those libraries should be
used. From time to time, Android Studio will ask you to update those versions, just
as it will ask on occasion for you to upgrade the version of Gradle specified in
gradle-wrapper.properties. Google maintains a page listing the Gradle versions

supported by each Android Gradle Plugin version
allprojects

The allprojects closure says “apply these settings to all modules in this project”.
Here, we are setting up jcenter () and google() as places to find libraries used in
any of the modules in our project. We will use lots of libraries in our projects —
having these “repositories” set up in allprojects makes it simpler for us to request
them. We will talk a bit more about libraries later in this chapter.

clean

Like many build systems, Gradle is based around tasks. Plugins and your own Gradle
files teach Gradle about various tasks that it should be able to perform when
requested. The clean() task in the top-level build. gradle file is one such task. As
written, this task is almost useless, and it is unclear why Google includes it, other
than perhaps to point out that you are able to define custom tasks.

The Module-Level Gradle File

In your app/ module, you will also find a build.gradle file. This has settings unique
for this module, independent of any other module that your project may have in the
future.

The Kotlin project’s edition of app/build.gradle includes a number of Kotlin
references:

plugins {
id 'com.android.application’
id 'kotlin-android'

b

android {
compileSdk 31

defaultConfig {
applicationId "com.commonsware.jetpack.hello"

minSdk 21
targetSdk 31
versionCode 1
versionName "1.0"
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testInstrumentationRunner "androidx.test.runner.AndroidJUnitRunner"

buildTypes {
release {
minifyEnabled false
proguardFiles getDefaultProguardFile('proguard-android-optimize.txt'), 'proguard-rules.pro’
}
¥
compileOptions {
sourceCompatibility JavaVersion.VERSION_1_8
targetCompatibility JavaVersion.VERSION_1_8
¥
kotlinOptions {
jvmTarget = '1.8'
}

dependencies {

implementation 'androidx.core:core-ktx:1.6.0"

implementation 'androidx.appcompat:appcompat:1.3.1"

implementation 'com.google.android.material:material:1.4.0'
implementation 'androidx.constraintlayout:constraintlayout:2.1.0'
testImplementation 'junit:junit:4.+'

androidTestImplementation 'androidx.test.ext:junit:1.1.3"
androidTestImplementation 'androidx.test.espresso:espresso-core:3.4.0'

...while the Java edition does not:

plugins {
id 'com.android.application’

b

android {
compileSdk 31

defaultConfig {
applicationId "com.commonsware.jetpack.hello"
minSdk 21
targetSdk 31
versionCode 1
versionName "1.0"

testInstrumentationRunner "androidx.test.runner.AndroidJUnitRunner"

buildTypes {
release {
minifyEnabled false
proguardFiles getDefaultProguardFile('proguard-android-optimize.txt'), 'proguard-rules.pro’
}
}
compileOptions {
sourceCompatibility JavaVersion.VERSION_ 1_8
targetCompatibility JavaVersion.VERSION_1_8
}
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H
dependencies {

implementation 'androidx.appcompat:appcompat:1.3.1"

implementation 'com.google.android.material:material:1.4.0'
implementation 'androidx.constraintlayout:constraintlayout:2.1.0'
testImplementation 'junit:junit:4.+'

androidTestImplementation 'androidx.test.ext:junit:1.1.3"
androidTestImplementation 'androidx.test.espresso:espresso-core:3.4.0'

b

The android closure contains all of the Android-specific configuration information.
The Android plugin will use this closure, where the plugin itself comes from the id
'com.android.application’ line at the top, coupled with the classpath line from
the project-level build.gradle file. We will explore some of the specific values
defined in this closure in the next section.

This build.gradle file also has a dependencies closure. Whereas the dependencies
closure in the buildscript closure in the top-level build.gradle file is for libraries
used by the build process, the dependencies closure in the module’s build.gradle

file is for libraries used by your code in that module. We will talk more about

libraries later in the chapter.
Requesting Plugins

The first lines in app/build.gradle usually request various plugins. The lines that
you added to the top-level build.gradle file specify sources of plugins, but those
libraries can have many different plugins, and you only need some of them. Plus, if
your project grows and you have more modules than just app, you might need a
different mix of plugins per module.

As a result, each module’s build. gradle file starts off with a plugin closure to
indicate what plugins are needed:

plugins {
id 'com.android.application'
id 'kotlin-android’

}

Both the Java and the Kotlin editions of the starter project will request the
com.android.application plugin. This teaches Gradle how to build Android apps.
There are other options here, such as com.android.library to teach Gradle how to
build an Android library, but nearly every project will have at least one module using
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com.android.application.

Kotlin-based projects will also request the kotlin-android plugin. This teaches
Gradle how to compile Kotlin code, particularly in the context of building an
Android application.

Android Plugin for Gradle Configuration

One of the most important areas for configuration in app/build.gradle is inside the
android closure. That configures the Android Plugin for Gradle, teaching it the
details of how you want your app to be assembled from its source code, resources,
etc.

In theory, this closure can get very complex. In practice, most apps will configure
just a few things, as the starter app does:

android {
compileSdk 31

defaultConfig {
applicationId "com.commonsware.jetpack.hello"
minSdk 21
targetSdk 31
versionCode 1
versionName "1.0"

testInstrumentationRunner "androidx.test.runner.AndroidJUnitRunner"

b

buildTypes {
release {
minifyEnabled false
proguardFiles getDefaultProguardFile('proguard-android-optimize.txt'), 'proguard-rules.pro’
}
¥
compileOptions {
sourceCompatibility JavaVersion.VERSION 1 8
targetCompatibility JavaVersion.VERSION_1_8
}
kotlinOptions {
jvmTarget = '1.8"'
}
}

Package Name and Application ID

In the previous chapter, we saw that there is a package attribute on the root
<manifest> element of a manifest, and that indicates where some code-generated
classes will go.
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The package value also serves as the default value for your application ID. However,
you can override it, as the starter app does, via an applicationId statement in the
defaultConfig closure inside that android closure.

The application ID is a unique identifier for our app, such that:

* no two apps can be installed on the same device at the same time with the
same application ID

* no two apps can be uploaded to the Play Store with the same application ID
(and other distribution channels may have the same limitation)

Convention says that the application ID starts with a reversed edition of some
domain name that you control, to reduce the likelihood of an accidental collision
with the application ID of some other developer.

compileSdkVersion, minSdkVersion, and targetSdkVersion

Back in the chapter introducing resources, we discussed the concept of API levels.
API levels are integers, with higher numbers indicating newer versions of Android. A
new API level is created for:

* Every major version of Android (e.g., Android 8.0 is API Level 26)

* Every minor version of Android (e.g., Android 8.1 is API Level 27)

* Some patch versions of Android (e.g., Android 4.0 was API Level 14, but
Android 4.0.3 was API Level 15)

We use those API levels in three key places in the module’s build.gradle file:
compileSdkVersion, minSdkVersion, and targetSdkVersion.

compileSdkVersion indicates what version of Android do we want to compile
against. Classes, methods, and other symbols that existed in Android at that time
(or from before) will be available to us at compile time, but newer things will not.
Usually, therefore, we set the compileSdkVersion to be a fairly modern API level,
such as the latest production version of Android.

minSdkVersion indicates what is the oldest version of Android you are willing to
support. So, if you are only supporting your app on Android 5.0 and newer versions
of Android, you would set your minSdkVersion to be 21. Older devices will be
incapable of installing your app, and your app will not appear in the Play Store app
for devices running an older version of Android.
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targetSdkVersion indicates what version of Android you are thinking of as you are
writing your code. If your application is run on a newer version of Android, Android
may do some things to try to improve compatibility of your code with respect to
changes made in the newer Android. However, from a practical standpoint,
nowadays the targetSdkVersion usually is the same value as the compileSdkVersion
— we update both of them at the same time to the same value.

Note that in Arctic Fox, you may see these values defined without the Version suffix,
as compileSdk, minSdk, and targetSdk.

Version Code and Version Name

The defaultConfig closure has versionCode and versionName properties. These two
values represent the versions of your application.

The versionName value is what the user will see for a version indicator in places like
the Settings app and the Play Store. This can be whatever string you want, using
whatever naming or numbering system that you want. However, for customer
support purposes, you should have some system that varies by release, rather than
using the same string all of the time.

The versionCode, on the other hand, must be an integer, and newer versions must
have higher version codes than do older versions. Android and the Play Store will
compare the version code of a new APK to the version code of an installed
application to determine if the new APK is indeed an update. The typical approach
is to start the version code at 1 and increment it with each production release of
your application, though you can choose another convention if you wish. During
development, you can leave these alone, but when you move to production, these
attributes will matter greatly.

Other Stuff in the android Closure

The android closure has a testInstrumentationRunner statement — we will explore
that more in an upcoming chapter, to see how testing works.

The android closure also has a buildTypes closure. This provides specific
configuration for different “build types”, such as debug for development builds and
release for production builds. The defaults provided in the starter project are fine
for many basic apps.
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The compileOptions and kotlinOptions closures indicate that we want the Java and
Kotlin compilers to generate JVM 1.8 bytecode. While JVM bytecode has advanced a
lot since then, 1.8 is the newest that Android supports at this time.

Libraries and Dependencies

Roughly speaking, the code and assets that make up an app come from three
sources:

1. The source that you and people that you know are writing for this app.

2. The source that comes from your compileSdkVersion, representing the
Android SDK that you are linking to.

3. Everything else, generally referred to as dependencies. These are libraries,
written by Google, independent Android developers, major firms, and so on.
Every modern Android app uses libraries, and bigger apps use more libraries.

From a pure technical standpoint, most dependencies are listed in build.gradle
files in dependencies closures. We have seen two of these in this chapter.

One dependencies closure appears in the project-level build.gradle file, inside of a
buildscript closure:

dependencies {
classpath "com.android.tools.build:gradle:7.0.2"
classpath "org.jetbrains.kotlin:kotlin-gradle-plugin:1.5.30"

// NOTE: Do not place your application dependencies here; they belong
// 1in the individual module build.gradle files
}

Those list places where Gradle plugins come from. You are always depending upon
the Android Gradle Plugin, and some other developers publish Gradle plugins that
you may elect to use in the future. Kotlin users will also use a Kotlin plugin.

However, the dependencies closure that we tend to think about the most is the one
in our module’s build.gradle file, such as app/build.gradle, such as this one from
the starter project:

dependencies {

implementation 'androidx.core:core-ktx:1.6.0'
implementation 'androidx.appcompat:appcompat:1.3.1"'
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implementation 'com.google.android.material:material:1.4.0"
implementation 'androidx.constraintlayout:constraintlayout:2.1.0"
testImplementation 'junit:junit:4.+'

androidTestImplementation 'androidx.test.ext:junit:1.1.3'
androidTestImplementation 'androidx.test.espresso:espresso-core:3.4.0'

}

Here, there are three types of statements:

* implementation says “here is a dependency that [ want to use for my actual
app’

* androidTestImplementation says “here is a dependency that I want to use
for testing”

* testImplementation says “here is a dependency that I want to use for... a
slightly different type of testing”

(we will explore the differences between those in an upcoming chapter)

Our starter project has eight statements in app/build. gradle attempting to pull in
dependencies:

* Three are tied to testing. We will be discussing those soon.

+ Two are tied to Kotlin (org.jetbrains.kotlin:kotlin-stdlib-jre7 and
androidx.core:core-ktx) and will not be seen in pure-Java projects.

* The constraintlayout and appcompat dependencies are specifically part of
Jetpack and are foundations for modern Android Ul development. We will
be spending quite a bit of the book going over what these offer and how you
use them.

* The com.google.android.material:material contains the Material
Components for Android, which we saw briefly back in the chapter on
resources

Most likely, you will be adding other similar statements to this set, plus perhaps
deleting ones that you are not actually using (e.g., the fileTree() one). We will see
how to add other libraries as the book progresses, as many of the things that are
common in Android app development require additional libraries.
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Our starter project has a bit of code, a bunch of resources, a manifest, and Gradle
build instructions. And, we can see the app running on a device or emulator.

However, Android is not running directly that bit of code and other stuff. Android
Studio compiles the things in our project into something that Android then runs.

In this chapter, we will take a brief look at what Android Studio is building for us
and how we can examine that output, beyond running it on Android.

What We Build

From the user’s standpoint, we are building an app. Usually, that is true. The story
can get complicated with specialized scenarios like Android Auto and Android Wear,
but we can ignore those for the time being.

From a programming standpoint, what you are creating is an APK, perhaps by way
of an app bundle.

APKs

An APK is the Android executable format. It is what gets installed on an Android
device, and it is what the device runs.

An APK is a ZIP archive. You can unpack one using your favorite unZIP tool, though
we will see a better option for many cases later in this chapter.

The APK will contain:
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* Your compiled code

* Your resources, usually in their own “compiled” format
* Your manifest, also in a “compiled” format

+ Other miscellaneous files

This includes not only the things that you create yourself but also the stuff that you
wind up using from libraries that are part of your app module.

App Bundles

The APK not only is what an Android device runs, but usually it is what Android app
developers publish. You use Android Studio to create the APK from your project,
and you upload that APK to the Play Store or other app distribution channels. The
Play Store or other site then distributes the APK to users.

You will hear Google talk about “app bundles” as an alternative. App bundles are
designed for large, complex apps, where only part of what goes in an APK will be
relevant for any given device. For example, a major brand APK may have strings
translated to many languages, but the user typically uses only one or two languages.
Having translations in other languages just takes up disk space and adds no value to
that individual user. App bundles allow Google to craft tailored APKs on your behalf
that match the needs of individual devices and users.

However, now you are no longer in control over what is in your app. Google is. While
Google likes to comment on what they can remove from your app (e.g., unnecessary
languages), they do not discuss whether they might add anything to your app or
otherwise modify its behavior. That could be for their benefit or for the benefit of
some third party.

You will need to decide for yourself whether the benefits of app bundles outweigh
the risks. Note, though, that Google has stated that app bundles will be required for
new apps being distributed through the Play Store starting in August 2021.
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Where They Go

When you run your app in Android Studio, it creates an APK to install on the device.
That APK will wind up inside of the module’s build/ directory. build/ contains all
sorts of outputs of the build process, the APK being chief among them:

HelloWorld
.gradle
idea
app
build
generated
intermediates
kotlin
outputs
apk
debug
£ output-metadata.json
logs
tmp
Figure 56: Android Studio Project build Contents

Specifically, when you start off, you will find the APK in build/outputs/debug/app-
debug. apk. By default, the filename will be based on your Gradle module name, so
an app/ module winds up with an APK with app in the name. And, by default, you
are creating a debug build — the sort of build that you as a developer will use — and
so the APK winds up in a debug/ directory and has debug in the name.

Building the APK

You can manually build the APK at any time through the Build menu in Android
Studio. For example, you might want to do that before trying to analyze the APK.

For creating an ordinary debug APK, choose Build > Build Bundles(s) / APK(s) >
Build APK(s) from the Android Studio main menu. After a few moments, a “toast”-
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style popup window should appear announcing the results:

@ Build APK(s)
APK(s) generated successfully:
Module 'app’: locate or analyze the APK.

Figure 57: Android Studio, Toast Showing Build Results

Analyzing the APK

One of the links in that toast is to “analyze” the APK.

Android Studio offers an APK Analyzer tool. Mostly, it exists to help developers see
exactly what is in the APK, blended from all of the possible sources (your code,
library code, etc.). For developers looking to reduce the size of the APK, the APK
Analyzer is great for seeing where the space goes.
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To bring up the APK Analyzer, either click that “analyze” link from a fresh build, or
choose Build > Analyze APK at any time. The latter will bring up a typical file

chooser dialog for you to navigate through the build/ directory to select the APK
that you want to analyze:

Select Path 2

Select APK to analyze

® X | 5| Hide path

&
generalea
intermediates
kotlin
outputs

apk
debug
[ L app-debug.apk
logs
tmp
libs
src
build
gradle

Drag and drop a file into the space above to quickly locate itin the tree

m | Cancel | | Help |
Figure 58: Android Studio, APK Selection Dialog
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The APK Analyzer then opens in a fresh tab:

app-debug.apk

com.commonsware.jetpack.hello (Version Name: 1.0, Version Code: 1)
© APK size: 4.1 MB, Download Size: 3.5 MB Compare with previous APK...
File Raw File Size Download Size% of Total Do...
o Classes.dex 2.9MB 27MB 8290
> bzres 2425 KB 2349KB T7.2W%
resources.arsc 690.3 KB 156.7KB 4.8%
o Classes2.dex 119.3 KB 106 KB 32.2%
> [ META-INF 57.3 KB E29KB 1.6%
> Im Kotlin 9.1KB 9KB 0.3%
o Classes3.dex 1KB 1002 B 0%
- AndroidManifest.xml 825B 825 B 0%

Figure 59: Android Studio, APK Analyzer

The starter project’s APK is a 3.5MB file. This may seem rather large for an app that
does not really do much. That is because:

+ Google’s starter projects include a lot of libraries, and
* A normal debug build does not eliminate unused stuff from those libraries

We will look into how to address that latter problem much later in the book.
The table shows the breakdown of where the space goes. Of note:

* The .dex files — and, where relevant, the kotlin/ directory — represent
your compiled code, both that you wrote, what was code-generated for you
by Android Studio, and what you get from libraries

+ The res/ directory and the resources.arsc file represent your resources

* The AndroidManifest.xml file is your manifest

We will explore these things much more later in the book and help you see how you
might make your app smaller.
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When we write Android apps, a chunk of our time is spent testing those apps. Some
of that testing is manual: poking at the UI and seeing if everything works as
expected. But some of that testing is automated, with test classes that test our “real”
classes and confirm that everything is OK.

With that in mind, let’s take a look at the types of tests that we have in the starter
project and how to run them.

Instrumented Tests

There are two major types of test in an Android app:

* Instrumented tests, which run in Android on a device or emulator
+ Unit tests, which run on your development machine or similar places

Unit tests run much faster, but they cannot test as much, because they do not have
access to everything inside of Android. For example, while we could test our ability
to talk to a Web service from unit tests, we cannot test our ability to get GPS
locations using Android APIs from unit tests. For those, we need instrumented tests.
Similarly, most automated Ul testing needs instrumented tests, as the Android Ul
system is only really available in Android.

Since they are more flexible, and since test speed only becomes a major issue with
larger projects, let’s focus first on instrumented tests.

Where They Run

As noted above, instrumented tests will run on an Android device or emulator. For

105

Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!
Attribution-ShareAlike 4.0 International license.



TOURING THE TESTS

your own personal test runs, you can use the same devices or emulators that you use
for manually running the app.

Projects that employ continuous integration (CI) servers will need to configure them
to support running tests on server-hosted emulators. Some hosted CI services —
such as CircleCI — have that capability readily available to you. For self-hosted CI
servers, there should be recipes available to teach you how to configure them for
Android app testing.

What You Can Test

Because you are running the tests in an actual Android environment, you can test
anything that you want. You have the full Android SDK at your disposal.

However, from a practical standpoint, there will be limits as to what you can test:

+ Emulators do not emulate everything about hardware. For example, you will
not be able to test readings that you get from nearby cell towers, as an
emulator is not in communication with any actual cell towers.

* You want your tests to be repeatable. Hence, even on hardware, you may
need to limit testing what you really get from the hardware, as you do not
control that hardware and what it might return. For example, while in theory
you could test getting actual location data via GPS from a device, you cannot
guarantee the precise values that will get returned, as GPS is inexact by its
very nature.

* Any given device has one set of hardware characteristics. Any given emulator
will mimic one set of hardware characteristics. Testing things that vary based
on hardware characteristics will require multiple test runs across a fleet of
devices or emulators that will reflect the varying characteristics.

What the Starter Project Has

The starter project not only has a “hello, world” sort of UI for you, but it has a
similar instrumented test set up, ready for you to run.

The androidTest Source Set

As we saw earlier in the book, instrumented test code resides in an androidTest/
directory. This is a peer to the main/ directory that contains your “real” application
code. androidTest/ is a “source set” that will be used only when running
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instrumented tests. The stuff in the androidTest/ source set will not be included in
your app when you ship it.

The Test Class

Inside of there you will find a java/ directory, with a Java package matching the
application ID of your app, and an ExampleInstrumentedTest Java or Kotlin file.

When you create a new project, and you choose whether or not to have Kotlin
support, that choice will determine not only whether your MainActivity is in Java or
Kotlin, but also whether your test code is in Java or Kotlin.

The Kotlin class is fairly short:

package com.commonsware.jetpack.hello

import androidx.test.platform.app.InstrumentationRegistry
import androidx.test.ext.junit.runners.AndroidJUnit4

import org.junit.Test
import org.junit.runner.RunWith

import org.junit.Assert.*

/**
* Instrumented test, which will execute on an Android device.
*
* See [testing documentation](http://d.android.com/tools/testing).
274
@RunWith(AndroidJUnit4: :class)
class ExampleInstrumentedTest {
@Test
fun useAppContext() {
// Context of the app under test.
val appContext = InstrumentationRegistry.getInstrumentation().targetContext
assertEquals("com.commonsware.jetpack.hello", appContext.packageName)

¥

The Java equivalent is not much longer:

package com.commonsware.jetpack.hello;

import android.content.Context;
import androidx.test.platform.app.InstrumentationRegistry;
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import androidx.test.ext.junit.runners.AndroidJUnit4;

import org.junit.Test;
import org.junit.runner.RunWith;

import static org.junit.Assert.*;

J**

* Instrumented test, which will execute on an Android device.
*

* @see <a href="http://d.android.com/tools/testing">Testing documentation</a>
274
@RunWith(AndroidJUnit4.class)
public class ExampleInstrumentedTest {
@Test
public void useAppContext() {
// Context of the app under test.
Context appContext =
InstrumentationRegistry.getInstrumentation().getTargetContext();
assertEquals("com.commonsware.jetpack.hello", appContext.getPackageName());

i3
¥

The Annotations

The Java and Kotlin editions of the test class are equivalent, other than language
syntax.

Both have a single class, named ExampleInstrumentedTest, annotated with a
@RunWith(AndroidJUnit4: :class) annotation. Android presently uses JUnit 4 for
instrumented tests. This annotation tells JUnit — and, more importantly, some
Android Studio stuff for running tests — that this class contains test code that
should be run as part of an instrumented test.

Both editions of ExampleInstrumentedTest have one method (or function, in
Kotlin). It is called useAppContext (), and it is marked with the @Test annotation. A
test class can contain one or more of these @Test methods/functions. When it
comes time to run the tests, Android Studio will:

+ Create an instance of your test class

« (Call one of the @Test methods/functions on that instance

+ Create another instance of your test class

« (Call another of the @Test methods/functions on that new instance

« And so on, until all of the @Test methods/functions have been executed
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The Test Code

So... what is useAppContext () testing?
In truth, it is not testing very much.

We will explore what a Context is a bit later in the book. For the moment, take it on
faith that this code is:

+ Finding out what our application ID is, by calling getPackageName() on a
Context

+ Confirming whether it matches the expected value of
com.commonsware. jetpack.hello

assertEquals() is supplied by JUnit 4 and will fail the test if the two values are not
equal.

We will explore much more about JUnit 4 and how to write more elaborate tests
much later in the book.

How You Run Them

For a single test method or function, you will notice a triangle-pair “run” icon in the
“gutter” area of the code editor:

@RunWith(AndroidJUnit4::class)
4 class ExampleInstrumentedTest {

@Test
4 fun useAppContext() {

// Context of the app under test.
val appContext : Context! = InstrumentationRegistry.getInstrumentation(
assertEquals( expected: "com.commonsware. jetpack.hello", appContext.pac

}

}
Figure 60: Android Studio, Showing Instrumented Test in Kotlin
109
Published under the Creative Commons Visit https://commonsware.com/licenses to learn more!

Attribution-ShareAlike 4.0 International license.



TOURING THE TESTS

Clicking that will allow you to run that individual test method/function. Or,
optionally, you will be able to debug that test method.

@RunWith(AndroidJdUnit4: :class)
» class ExamplelnstrumentedTest {
@Test

N RPN | T e S S . 1 [

» Run 'useAppContext() Ctrl+Shift+F10

# Debug 'useAppContext() app under
@ Profile 'useAppContext() text! = Ins
" Create 'useAppContext()... ed: "com.co

}
}

Figure 61: Android Studio, Showing Pop-Up Menu for Running a Test Function

Similarly, there is a “run” icon in the gutter next to the class name, to run all of the
test functions in the Kotlin test class. For a Java class, the class-level test icon is a
“double-run” pair of overlapping green triangles:

@RunWith(AndroidJUnit4.class)
}> | public class ExamplelnstrumentedTest {
@Test
[> public void useAppContext() {
// Context of the app under test.
Context appContext =
InstrumentationRegistry.getInstrumentation().getTargetContext();

assertEquals( expected: "com.commonsware. jetpack.hello", appContext.g
}
}

Figure 62: Android